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History of Changes 0

Date Changes Reason

03/2012 First draft

2012-04-23 Upgrade table in Section 2.1, “Upgrade Versions”, on page 13 updated

2012-09-03 New note in Section 2.9, “Upgrading from XPR V6 32-bit to XPR V7”, Section 
2.11, “Upgrading from MRS 8.03 to XPR V7” and section “Upgrading XPR V6 
64-bit to XPR V7”

CQ00215677

2012-09-04 Table for upgrading from V5 to V7 supplemented CQ00219597

2012-09-07 New Section 2.10, “Upgrading from XPR V5 to XPR V7”

2012-09-07 Section 2.9, “Upgrading from XPR V6 32-bit to XPR V7”, Section 2.11, 
“Upgrading from MRS 8.03 to XPR V7” and section “Upgrading XPR V6 64-
bit to XPR V7”corrected

CQ00201017

2012-09-07 Satellite system: Note in Section 2.12.2, “Preparing the Satellite Computers” 
and new Section 2.12.4, “Host Name of the Satellite Computer”

CQ00221310

2012-09-14 Disabling IPv6: Note in Section 2.3.1.1, “Server with Operating System 
Windows Server”

CQ00215681

2013-05-24 The supported operating systems have been updated (see Section 2.3.1.1, 
“Server with Operating System Windows Server”, on page 16). 
The operating system that are supported for clusters have been added (see 
point 1 on page 122).

FRN5992

2013-05-24 Section 2.3.4, “Setup Medium for Upgrading to a Fix Release”, on page 29 
added.

FRN5399

2013-05-24 Some upgrades include a fresh installation of the XPR server. During this 
installation, the same password must be used for user PGROOT of the 
PostgreSQL database as was used for setting up the old XPR system (see 
Section 2.10.2, “Installing the XPR V7 Server”, on page 97, Section 2.9.2, 
“Installing the XPR V7 Server”, on page 90 and Section 2.11.2, “Installing the 
XPR V7 Server”, on page 106).

CQ00201017

2013-06-13 Section 2.8.2, “Silent Upgrade”, on page 84 added. FRN6055

2013-11-18 Section 2.3.1.1, “Server with Operating System Windows Server”, on page 
16:
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supported.

2013-11-18 Additional steps are required for voice messages when upgrading from 
XPR V5 32-bit or MRS 8.03 to XPR V7 (see step 3 on page 100 and step 3 
on page 109)

CQ00264840

2013-11-18 Audio conferences are no longer supported for HiPath 3000 V5, V6 and V7 
and for HiPath 4000 V3 and V4 (see Section 2.1, “Upgrade Versions”, on page 
13 and point 7 on page 122).

2013-11-18 The name “Unify” has been introduced.



History of Changes Nur für den internen Gebrauch

 A31003-S2370-J102-15-7631, 11/2014
6 OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation

HistoryOfChange.fm

2013-11-18 The sections Section 2.9, “Upgrading from XPR V6 32-bit to XPR V7”, on 
page 87, Section 2.10, “Upgrading from XPR V5 to XPR V7”, on page 94 and 
Section 2.11, “Upgrading from MRS 8.03 to XPR V7”, on page 103 have been 
restructured.

Information about upgrading XPR V6 64-bit to XPR V7 R1 has been moved 
without modifications (see step 2 on page 64, step 57 on page 83 and step 58 
on page 83).
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FRN7927

2014-02-10 Links in Section 2.3.1, “Checking the System Requirements for the Server 
PC”, on page 16 updated

CQ00283457

2014-02-10 When upgrading XPR V6 32-bit to XPR V7, install the highest MTA hofixes 
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2014-02-10 VMware ESXi V5.5 is supported (see Section 2.3.1.1, “Server with Operating 
System Windows Server”, on page 16).

FRN7740

2014-02-10 “Lotus Notes” has been replaced by “IBM Notes” for version 9 and higher.

2014-05-19 Upgrade from versions lower than XPR V5 removed (see Section 2.1, 
“Upgrade Versions”, on page 13)

2014-05-19 Refer to the service documentation OpenScape Xpressions Release Notice 
for details about the supported operating systems (see Section 1.1, “Who 
should read this Manual?”, on page 9, Section 2.3.1, “Checking the System 
Requirements for the Server PC”, on page 16, Section 2.3.1.1, “Server with 
Operating System Windows Server”, on page 16, Section 2.3.12, “Automatic 
Speech Recognition (ASR)”, on page 52 and point 1 on page 122).

2014-06-11 Execute the clusterprep.exe file before upgrading XPR (see step 7 on 
page 124 and step 4 on page 134).

CQ00298170

2014-06-11 Upgrading XPR on Windows Server 2012 in the cluster added(see Section 
3.2.2, “Upgrading XPR on Windows Server 2008/2012 in the Cluster”, on 
page 134)

2014-06-24 Verify the XPR authentication parameters after the upgrade (see step 55 on 
page 82, step 12 on page 85, step 2 on page 90, step 2 on page 97, step 2 on 
page 106, step 14 on page 126 and step 16 on page 137).

CQ00304303

2014-07-02 You must start certain files to start the license service automatically on a 
cluster after an upgrade and a fail over (see step 15 on page 127 and step 17 
on page 138).

CQ00303492

Date Changes Reason
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Nur für den internen Gebrauch History of Changes

2014-11-03 We recommend to execute the CompactDB tool to reduce the database size 
(see step 52 on page 81, step 13 on page 86, step 12 on page 126 and step 
13 on page 136).

CQ00300916

2014-11-03 Refer to the OpenScape Xpressions Release Notice for a list of the supported 
operating systems and Dialogic/Eicon ISDN boards (see Section 2.3.1.1, “Server with 
Operating System Windows Server”, on page 16 and Section 2.3.3.1, “Dialogic/Eicon 
ISDN Boards”, on page 28).

Date Changes Reason
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Introduction

Who should read this Manual?

1  Introduction

This manual describes how to upgrade your Xpressions system to XPR V7.

Upgrading to XPR V7 directly is supported only with restrictions. You may have 
to perform an upgrade to an intermediate version first before you can start 
upgrading to XPR V7.

You can also upgrade to XPR V7 from an MRS system.

IMPORTANT: Please refer to Section 2.1, “Upgrade Versions”, on page 13 to 
see which upgrade procedure is appropriate for your system.

1.1  Who should read this Manual?

This manual addresses system administrators who want to upgrade the XPR 
system to the product version 7. In order to understand the described functions 
and processes, the reader must have specialized knowledge in the following 
areas:

• Administration and configuration with or without a Windows cluster

• Network technology

• Installation and configuration of the XPRsystem. You can acquire such 
knowledge by taking part in a seminar of the Unify Software and Solutions GmbH & Co. KG.

• Configuration of the PBX used in connection with the XPRsystem.
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1.2  Required Tools

1.2.1  Manuals

During the XPR installation and configuration the following Cycos manuals in 
electronic or printed format will be referred to:

1.3  Document Conventions

Passages in the text conveying important information are indicated by striking 
symbols. 

IMPORTANT: Such a section points to settings and processes to be performed 
with special care. 

NOTE: Such a section marks passages in the text that contain additional notes 
or supplementary examples.

Part number Documentation type Title

A31003-S2370-S100-*-20 Service documentation Release Notice

Current development information Release notes

A31003-S2370-J100-*-31 Installation guide Server Installation 

A31003-S2370-J101-*-31 Installation guide Cluster Installation

A31003-S2370-J103-*-31 Installation guide Client Installations

A31003-S2370-M100-*A9 Administrator documentation Server Administration

A31003-S2370-M101-*A9 Installation and administrator documentation Microsoft Exchange Gateway

A31003-S2370-M102-*A9 Installation and administrator documentation IBM Notes Gateway

A31003-S2370-M103-*A9 Installation and administrator documentation SAP R/3 Gateway

A31003-S2370-U100-*-19 User guide Client Applications

A31003-S2370-U101-*-19 User guide Web Assistant

A31003-S2370-U104-*-19 User guide optiClient 130

A31003-S2370-U118-*-19 User guide Communications
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1.4  Acronym Directory

The following table lists the most important acronyms used in this manual in 
alphabetical order.

Acronym Description

ACD Automatic Call Distributor

APL Access Protocol Layer

ASR Automatic Speech Recognition

BRI Basic Rate Interface

CLA Customer License Agent

CLC Customer License Client

CLM Customer License Management

CLS Central License Server

CRM Customer Relationship Management

CSTA Computer Supported Telecommunication Applications

CTI Computer Telephony Integration

DTMF Dual Tone Multi Frequency

ERP Enterprise Resource Planning

GUI Graphical User Inteface

HKLM HKEY_LOCAL_MACHINE

HTTP Hypertext Transfer Protocol

IDE Integrated Device Electronics

IMAP4 Internet Message Access Protocol

IP Internet Protocol

IVR Interactice Voice Response

LDAP Lightweight Directory Access Protocol

MMCC Multimedia Contact Center

MWI Message Waiting Indicator

POP3 Post Office Protocol

PRI Primary Rate Interface

RPC Remote Procedure Call

SCSI Small Computer System Interface

SMS Short Message Service

SMTP Simple Mail Transfer Protocol

SOAP Simple Object Access Protocol

SSDP Smart Services Delivery Platform

TAPI Telephony Application Programming Interfaces

TCP Transmission Control Protocol
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TTS Text to speech

UCC Unified Communications and Collaboration

UM Unified Messaging

VM Virtual Machine

VMS Voice Mail Server

VPIM Voice Profile for Internet Mail

XML Extended Markup Language

XPR OpenScape Xpressions

Acronym Description
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Upgrading an XPR without Cluster

Upgrade Versions

2  Upgrading an XPR without Cluster

This upgrade instruction guides you through the procedures to be considered for 
the possible XPR components.

Only a portion of the processes described here may be relevant for the system to 
be upgraded.

2.1  Upgrade Versions

You can upgrade to version OpenScape Xpressions 7 R1 only from versions 
MRS 8.xx, OpenScape Xpressions 5.0 R4 FR13, 6 R0, 6 R1, 6 R2 and 7 R0.

Please obtain from the following table the possible previous versions and the 
intermediate versions that may be required for an upgrade. You find information 
about upgrading to an intermediate version in the upgrade instructions of the 
intermediate version.

For both installations and upgrades alike applies that audio conferences are not 
supported for an XPR connected to HiPath 3000 V5, V6 and V7, HiPath 4000 V3 
and V4, because the program SIPControl is no longer supported by Dialogic Diva. 

From version Bit Width via the intermediate version(s) to version

XPR 7 R0 64 - XPR 7 R1

XPR 6 R2 64 - XPR 7 R1

32 -1 2 3 XPR 7 R1

XPR 6 R1 32 -4 1 2 3 or XPR 6 R22 5 XPR 7 R1

XPR 6 R0 32 -4 1 2 3 or XPR 6 R22 5 XPR 7 R1

MRS 8.xx 64 -1 2 6 or MRS 8.032 5 XPR 7 R1

32 -1 2 6 or MRS 8.032 5 XPR 7 R1

XPR 5.0 R4 32 XPR 5.0 R4 FR131 2 7 or XPR 6 R22 XPR 7 R1

XPR 5.0 R3 32 XPR 5.0 R4 FR131 2 7 or XPR 6 R22 XPR 7 R1

XPR 5.0 R2 32 XPR 5.0 R4 FR131 2 7 or XPR 6 R22 XPR 7 R1

XPR 5.0 R1 32 XPR 5.0 R4 FR131 2 7 or XPR 6 R22 XPR 7 R1

XPR 5.0 R0 32 XPR 5.0 R4 FR131 2 7 or XPR 6 R22 XPR 7 R1

MRS 7.xx 32 MRS 8.032 XPR 7 R1
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1 You upgrade the XPR 6 R2 32 bit, XPR 6 R1, XPR 6 R0, XPR 5.0 R4 FR13 or MRS 8.xx to XPR 
7 DIRECTLY by executing the following major steps: 
- Making the TOV7 (to version 7) check box visible in the WebAssistant
- Backing up MRS/XPR data
- Uninstalling the MRS/XPR
- Installing the XPR 7 freshly
- Restoring the backed up data
If the TOV7 check box is unavailable on your MRS/XPR server, check that the corresponding 
hotfixes have been installed instead. You can obtain details on this subject from section 2.2 of the 
current Release Notes.
You do not need TOV7 for a “normal” upgrade without data backup and restore.

2 IMPORTANT: Given that you have one of the following initial situations:
- XPR or MRS on a Windows cluster on a 32-bit operating system 
- MRS 8.xx on a Windows cluster 
Supposing that you do not have a project-specific release for a Connection APL on a satellite 
computer in addition.
If you wish to upgrade on a Windows cluster (always on a 64-bit operating system) on XPR 7 R1, 
a project-specific release is required for XPR 7 R1, because specific parts of the Connection APL 
on a satellite computer are needed for this upgrade. See also point 33 on page 75, point 7 on page 
79 and point 4g on page 90.
The same applies if you wish to upgrade XPR 5.0 R4 FR13 to XPR 7 R1 on a Windows cluster 
directly.

3 The XPR WebClient data will not be backed up before this upgrade, so that you must configure 
them in the XPR 7 WebClient manually after the upgrade.

4 Upgrades from XPR 6 R0 or 6 R1 to XPR 7 are released only for the case that no conferences are 
activated on your XPR.

5  This intermediate step is only necessary if conferences are activated on your MRS or XPR.
6 You can perform this upgrade only if MRS 8.03 is present or no conferences are activated on your 

MRS.
MRS 8.xx cyPhoneWeb data will not be backed up before the upgrade, so that you must configure 
them in the XPR -7 WebClient manually after the upgrade.

7 Comply with or heed the following points:
Verify that the TOV7 check box is available.
Instead of the XPR 5.0 SMS APL there is the SMSIP APL on XPR 7. Consequently, the SMS APL 
configuration will get lost during the upgrade. The password of user Network Administrator and the 
Local Profile are kept during the upgrade only if the computer name (host name) and the IP 
address of the XPR 5 server computer are also used for the XPR 7 server computer.
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2.2  Basic Upgrade Procedure

IMPORTANT: The upgrade steps described here are valid for an upgrade from 
XPR V6 R2 to XPR V7 R1 on a 64-bit operating system. If you wish to upgrade 
from an XPR V6 R2 on a 32-bit operating system, then switch to Section 2.9, 
“Upgrading from XPR V6 32-bit to XPR V7”, on page 87.

How to upgrade to OpenScape Xpressions V7 R1:

1. Preparatory Steps Section 2.3, “Preparatory Steps”, on 
page 16

a) Checking the System 
Requirements for the Server PC

Section 2.3.1, “Checking the System 
Requirements for the Server PC”, on 
page 16

b) Backup Section 2.3.2, “Backup”, on page 20

c) Drivers for Communication 
Hardware

Section 2.3.3, “Drivers for 
Communication Hardware”, on page 
28

d) Licenses Check Section 2.3.5, “Licenses Check”, on 
page 36

2. Updating the XPR Server Software 
and Client Components

Section 2.4, “Updating the XPR 
Server Software and Client 
Components”, on page 58

3. Upgrading Satellite Computers Section 2.12, “Upgrading Satellite 
Computers”, on page 112

4. Modified and new Features Section 2.13, “Modified and new 
Features”, on page 116
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2.3  Preparatory Steps

2.3.1  Checking the System Requirements for the 
Server PC

IMPORTANT: The hardware used must have been tested and released by the 
producer of the operating system. For information about tested and released 
hardware, please refer to the following address:

http://www.windowsservercatalog.com/default.aspx 

NOTE: TTS and ASR have been released only for specific operating systems 
(see the service documentation OpenScape Xpressions Release Notice). 

2.3.1.1  Server with Operating System Windows Server

If you work with the Windows Server operating system platform, the following 
minimum requirements of the server computer should be met:

• Processor

– Intel Pentium 4 (or compatible) (Xeon processor and dual-core system), 
at least 2 GHz 

– Using T.38 Fax on more than two parallel lines requires a server with at 
least 2 GHz, at least 2 GB RAM and at least one dual core system

– For conference usage one additional core per 50 voice channels

– Using the OpenScape Web Client a powerful processor depending on the 
number of users and sessions. The performance requirement per 
OpenScape Web Client user is approximately twice as high as for a 
optiClient 130 user.

• Working memory

– 2 GB (recommendation: 4 GB)

– in case of TTS usage

• additional 100 MB per installed TTS voice of Nuance Vocalizer for 
Network 5 and

• additional 2MB per channel
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at least, however, 1 GB in addition

– in case of ASR usage 512 MB in addition

– in case of conference usage 2 GB in addition 

– in case of OpenScape Web Client usage at least 1 GB in addition

• Hard disks

2 hard disks with at least 100 GB (IDE or SCSI) each.

IMPORTANT: Be sure that the partition on which the XPR server software is 
installed has a minimum size of 10 GB. In addition, the target path must not 
contain any blanks!

• Second hard disk for data backup recommended

• USB-Port for installing the XPR from the setup medium

• LAN

Ethernet 100 Base T or Gigabit

– The network board must be connected to the LAN to ensure trouble-free 
XPR server booting.

– The network board settings must correspond to those of the router/HUB.

– An MS Loopback Adapter must be installed.

– If the web conference server and a WebAPL is to be installed on the 
computer that also hosts the XPR server, the following requirements must 
have been complied with:

• The computer must have two IP addresses or two DNS host entries 
that point to the same IP address.

• Port 80 (TCP) and port 5000 (TCP) must be accessible.

IMPORTANT: Protocol IPv6 must be disabled.

• Slots

When using ISDN boards, PCI respectively PCIe slots are required 
depending on the boards to be deployed.
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• Operating systems

IMPORTANT: Be sure that the partition on which the XPR server software is 
installed has a minimum size of 10 GB. In addition, the target path must not 
contain any blanks!

Refer to the service documentation OpenScape Xpressions Release Notice 
for details about the supported operating systems.

• Correctly configured TCP/IP protocol stack 

IMPORTANT: If a replacement of the network card changes the MAC ID of the 
computer on which the CLA is installed, a new license file must be installed via 
the HLM, because the licenses are bound to the MAC ID of the network card.

IMPORTANT: The installation of an XPR system on substituted drives is not 
possible, since the setup program cannot create the required directory shares of 
the XPR system.

IMPORTANT: Installing the XPR system on a domain controller is not permitted.

IMPORTANT: You must not set up an XPR on a computer on which a ComAs-
sistant is installed. In this context it is irrelevant whether or not the XPR is to be 
integrated in the ComAssistant.

IMPORTANT: If an XPR integrated with a ComAssistant is to be upgraded, the 
following assignments must have been entered in the 
<Inst_Path>\config\common\Xpressions.cfg file on the computer that 
hosts the ComAssistant:
Xpressions.remotePort=10000
Xpressions.localPort=10001
See step 56 on page 83.

IMPORTANT: OpenScape Web Client must not be installed if the XPR is 
integrated with a ComAssistant. In this case you may consider the replacement 
of the ComAssistant with the OpenScape Web Client integrated in Xpressions.
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• Web conference server

The web conference server must comply with the following minimum 

requirements:

– Processor and RAM

• Up to 20 parallel sessions: Pentium 4 computer with more than 2 GHz 
with 512 MB RAM

• 20 - 100 parallel sessions: Xeon with 2,5 GHz and 1 GB RAM

– We recommend free memory of 50 GB for file transmissions during 
sessions. The harddisk size is not critical since, with the exception of 
writing log files, no considerable data amount is written on the harddisk.

– We recommend a network board with 1 Gbit/s.

– Operating systems 

• Microsoft Windows Server 2008 Enterprise Edition German/English 
in the 64-bit version

• Microsoft Windows Server 2008 Standard Edition German/English in 
the 64-bit version

• Microsoft Windows Server 2003 R2 with SP2 Enterprise Edition 
German/English in the 64-bit version

• Microsoft Windows Server 2003 R2 with SP2 Standard Edition 
German/English in the 64-bit version

– No IIS (Internet Information Server) or another web server must have 
been installed.

– Bandwidth to the internet

• In each session, 15 kbit/s must be made available per simultaneously 
connected master and per simultaneously connected client. If 10 
parallel sessions take place, i. e. there are 10 masters and 10 clients, 
a bandwidth of 300 kbit/s is required.

• When using top video quality, the necessary transmission rate is ten 
times higher.

– Port 80 (TCP; HTTP), port 443 (TCP; HTTPS) and port 5000 (TCP) must 
be accessible. When using HTTPS, a certificate must be present for each 
server. Using HTTPS increases the necessary bandwidth via proxy 
server.

– Every server requires an IP address. IP V6 is not supported yet.

– Virtualization is supported. See the OpenScape Xpressions Release 
Notice for the supported versions and features.
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– Installing the web conference server and a WebAPL on the computer on 
which the XPR server is set up requires two IP addresses or two DNS 
host entries that point to the same address.

2.3.2  Backup

To ensure that you have a fallback solution when an upgrade cannot be carried 
out successfully, please perform the following steps for backup: First make sure 
that the following requirements are met:

• Keep the setup media of the Windows operating system at hand. They should 
be provided by the customer.

• Keep the setup medium of the old system at hand. It should be provided by 
the customer.

• Create a backup directory on the XPR server computer or on a network drive 
where you can store the saved files (for example C:\backup).

NOTE: Create images of the hard disks used for the XPR server and save 
the created images externally (for example on a network drive). If the 
upgrading fails, this is the most efficient way to restore the previous system.

IMPORTANT: The restoration requires that all installation and data direc-
tories have the same name. The restoration of new installation directories is 
not supported. 

What you do after laying the foundations:
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Exporting the XPR server database

Export the XPR server database completely. Proceed as follows:

1. Click on Start in the taskbar.

2. Click Run.... A dialog opens.

3. Enter cmd in the entry field. 

4. Click OK. A command prompt opens.

5. In the command prompt enter the command 

x:

with x representing the letter of the drive on which the XPR server setup 
directory is found.

6. Enter the command 

cd < Install>\SDKTools 

, with < Install> representing the XPR server setup directory.

7. Then enter the command

infotool fullexport file=<Backup>\fullexport.txt 

, with <Backup> representing the backup directory you have created.
The database export may take some time for XPR systems with large 
databases.

8. Close the command prompt.

The XPR server database export is now complete.
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Backing up important files

If you have changed the <XPR 
Install>\res\WebApl\ippassistant\param.xml file, it must be backed up 
because it may be overridden during the upgrade.

Backing up important directories

Back up the statistics and log files under 

• <XPR_Install>\Stat and 

• <XPR_Install>\Log, 

as well as the directories

• <XPR_Install>\Folders and 

• <XPR_Install>\Userdata with all sub-directories. 

Copy these folders into a backup folder for this purpose. Proceed as follows:

1. Click Start in the task bar with the right mouse button.

2. Select the Explore menu entry.

3. Navigate to the XPR server setup directory.

4. Click the Log folder entry with the right mouse button.

5. Select the Copy function in the context menu.

6. Navigate to the backup directory you have defined.

7. Click the folder entry with the right mouse button and select Paste in the 
context menu.

8. Back up the directories Stat, Folders and Userdata analog to the steps 
4 on page 22 to 7 on page 22 described for the Log directory.

Backing up the directories is now complete.
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Backing up/restoring relevant registry entries

Save the entries from the Windows registry relevant for the XPR server, so that 
the settings may later be checked or recovered. Proceed as follows:

1. Click the Start button in the task bar.

2. Click Run.... A dialog opens.

3. Enter regedt32 in the input field. The registry editor opens.

4. Navigate to the
HKEY_LOCAL_MACHINE\Software\Wow6432Node\PP-COM folder. 

5. Click the PP-COM folder with the right mouse button.

6. Select the Export function in the context menu. A dialog opens in which you 
need to specify a name and a storage location for the exported data.

7. In this dialog, navigate to the backup directory you have defined and enter a 
file name in the File name: field 
(e.g. xpr.reg).

8. Then click the Save button.

9. Close the registry editor.

Saving the relevant entries from the Windows registry is thus complete. 
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Database mask export

If customer-specific modifications have been performed at the database 
schema, a mask export of the database is necessary. Proceed as follows:

1. Click on Start in the taskbar.

2. Click Run.... A dialog opens.

3. Enter cmd in the entry field. 

4. Click OK. A command prompt opens.

5. In the command prompt enter the command

cd x 

with x representing the letter of the drive on which the XPR server setup 
directory is found.

6. Enter the command 

cd < Install>\SDKTools 

, with < Install> representing the XPR server setup directory.

7. Then enter the command

infotool maskexport file=<Backup>\maskexport.mdl 

, with <Backup> representing the backup directory you have created.

8. Close the command prompt.

The database mask export is thus complete.
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Backing up the maintenance script modifications

Customer-specific modifications performed at the maintenance script should be 
backed up as they will be overwritten by the default maintenance script during the 
upgrade.

To back up the maintenance script, you must save the modified version under a 
different name in the <XPR Install>\res\maint directory. This new name with 
complete path specification must then be entered in the MaintenanceScript 
[REG_SZ] registry value.

How to enter a modified Maintenance Script version in the registry:

1. Click the Start button in the task bar.

2. Click Run.... A dialog opens.

3. Enter regedt32 in the entry field. The registry editor opens.

4. Open the
HKEY_LOCAL_MACHINE\Software\Wow6432Node\PP-COM\MRS\MTA 
entry. 

5. Doubleclick the MaintenanceSkript entry in the right window. The Edit 
String dialog opens.

6. In the Value data field of this dialog enter the path and the name that you 
have selected when saving the file. 
For example: C:\xpr\res\maint\maint_custom.scr 

7. Click OK to save the modified value.

8. Close the registry editor.
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2.3.2.1  Saving User-defined Routing Rules

Save user-defined routing rules in a text file. For this purpose you can open the 
rule editor in the Routing Rules tab of the MTA configuration dialog via the 
Modify... buttons. Then copy its content via the clipboard to a text file. Save the 
text file with the Routing Rules in Proceed as follows:

1. Start the XPR monitor and log in with the administrator account for the XPR 
server.

2. In the Modules window open the MTA entry via the corresponding plus 
symbol.

3. Doubleclick the Edit Settings entry. The Message Transfer Agent (MTA) 
Configuration dialog opens.

4. Open the Routing Rules tab.

5. Click the Edit button in the Document Routing Rules section.

6. Click the text entry area with the right mouse button and choose the Select 
All option in the context menu. The entire text in the window is selected.

7. Click the text entry area with the right mouse button again and select Copy in 
the context menu.

8. Then click the Cancel button. The text window closes.

9. Click the Start button in the task bar and select the Run... option. The Run 
dialog opens.

10. Enter notepad in the entry field. The Notepad editor starts.

11. Click the text entry area of the editor with the right mouse button and select 
Paste in the context menu. 

12. In the Notepad menu open the File > Save As menu option. The Save As 
dialog opens.

13. Navigate to the above created backup directory and specify the file name 
under which the routing rules are to be stored (for example routingrules.txt).

14. Click the Save button.

15. Close Notepad.

2.3.2.2  Backing up Reports

So that the new Report APL version can be installed during the upgrade, the old 
Report APL version must first be uninstalled. The available reports are deleted in 
this process. If you have made modifications to these reports, you need to back 
them up. Proceed as follows:
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1. Open the XPR setup directory.

2. Open the res directory.

3. Copy the RepApl directory to a temporary directory (e.g.: c:\backup).

Backing up the reports is complete.
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2.3.3  Drivers for Communication Hardware

2.3.3.1  Dialogic/Eicon ISDN Boards

IMPORTANT: At times, Dialogic uses different version numbers for the same 
board. For example, the hardware description features a specific version number 
for a board, but in the Dialogic Diva Configuration Manager you find another 
version number for the same board. The version numbers used for Dialogic ISDN 
boards in this XPR V7 R1 guide are always the version numbers specified in the 
Dialogic Diva Configuration Manager!

Refer to the OpenScape Xpressions Release Notice for a list of the supported 
Dialogic/Eicon ISDN boards.

Mixed operation between different BRI or PRI cards as well as mixed operation 
of BRI and PRI cards on a server computer is not released.

During the driver setup, (see step 26 on page 73 to step 32 on page 75) settings 
are copied for the available boards. New boards are supported and recognized 
during the Dialogic/Eicon driver setup.
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2.3.4  Setup Medium for Upgrading to a Fix Release

NOTE: Skip this section if the complete setup medium of the XPR version you 
wish to upgrade to is already available.

NOTE: The instructions given in this section apply only for an upgrade to a fix 
release on a non-cluster system.

NOTE: The instructions given in this section do not apply for the upgrade on 
satellite computers.

If you wish to upgrade to a new fix release, you can create a setup medium for 
the upgrade from the setup medium of the installed XPR version and an 
additional EXE file by executing the following steps:

1. Provide a Windows computer that has sufficient disk space. Remember that 
the files to be unpacked and also the setup medium to be created will allocate 
disk space.

2. Make sure that the Microsoft Visual C++ 2005 Redistributable (vcredist 2005) 
is present of this computer. 

3. Both, 32-bit and 64-bit operating systems are supported.

4. Download the XPRV7R1-FR0-FR1.exe file from the SWS (Software Supply 
Server) computer.

5. If you wish to upgrade ASR also, download the XPRV7R1-FR0-FR1-
ASR.exe file from the SWS computer as well.

6. Such files have been created for a specific XPR build number. Provide the 
setup medium of the same build number. You find this number in the 
XpressionsInstall\HiSPA.txt file of a setup medium.

Example of the content of the HiSPA.txt file:

Product= OpenScape Xpressions V7 DVD
Version= 8.11.0.16072

In this example, 16072 is the build number.
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7. Start the XPRV7R1-FR0-FR1.exe file. 

NOTE: If the build number of the file does not match the build number of the 
setup medium, an error message of the following pattern is put out:
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8. Click on Next.

9. Enter in the OpenScape Xpressions Media to be updated field the directory 
that contains the XPR setup medium (see step 6 on page 29).

10. Specify in the Enter the destination path field the directory in which the XPR 
setup medium shall be created for the upgrade.
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11. Click on Next.

12. Creating the setup medium for upgrading the XPR server except ASR is now 
complete. Click on the Cancel button. If you clicked on Finish, upgrading the 
XPR server would commence.

13. Click on This program installed correctly.
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14. If you wish to upgrade ASR also, execute the steps 15 on page 33 to 21 on 
page 35.

15. Start the XPRV7R1-FR0-FR1.exe file. 

NOTE: If the build number of the file does not match the build number of the 
setup medium, an error message of the following pattern is put out:
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16. Click on Next.

17. Enter in the OpenScape Xpressions Media to be updated field the directory 
that contains the XPR setup medium (see step 6 on page 29).

18. Specify in the Enter the destination path field the directory in which the XPR 
setup medium shall be created for the ASR upgrade.
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19. Click on Next.

20. Creating the setup medium for upgrading ASR of the XPR server is now 
complete. Click on the Cancel button. If you clicked on Finish, upgrading the 
XPR server would commence.

21. Click on This program installed correctly.

22. Provide the created setup media to the XPR server computer.
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2.3.5  Licenses Check

When replacing the network card and changing the server hardware 
configuration, the MAC ID used must definitely be checked. If the MAC ID 
changes, the old MAC ID is locked and a new license file must be installed for the 
new MAC ID. 

You can obtain a new license file via the license server under the URL
https://www.central-license-server.com/license-management/session/login.htm 
as no license disks are shipped anymore. Have the order and delivery note 
number ready for this at any rate.

Licensing is comprehensively explained in the OpenScape Xpressions Server 
Installation manual.

NOTE: You can add an OpenScape Xpressions V7 R1 license to an already 
existing HiPath Xpressions V5 license in the HLM.

IMPORTANT: In case of an XPR V7 R0 upgrade with the web conferencing 
server you must update the license.



Upgrade.fm

Upgrading an XPR without Cluster

Preparatory Steps

A31003-S2370-J102-15-7631, 11/2014
OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation 37

       

2.3.6  Installation of the License Management and 
License Service

The HiPath License Management (CLM) is in charge of the license management 
for the XPR server. This HiPath License Management must already be available 
in the network before you can perform the upgrade. Furthermore, a Customer 
License Agent (CLA) must be installed in the network, for which the licenses for 
the XPR server have already been activated with the help of the CLM. Information 
on activating the necessary licenses can be found via the Help button in the 
HiPath License Management interface.

Besides the HiPath License Management, which may be installed on any 
computer in the network, a license service is installed on the computer on which 
the XPR server is also to be installed. The XPR server modules communicate 
with the CLA via the license service. This service is a Windows service that 
provides the XPR server modules with the required license information. Upon the 
setup start a local license service already installed may be upgraded. If such a 
local license service is not available it will be installed (cf. Section 2.8.1, “Standard 
Upgrade”, on page 63, step 5 on page 64). 

Before you can set up a OpenScape Xpressions server, the following 
requirements must be met: 

• A CLM must be available in the network (cf. Section 2.3.8, “Installation of the 
CLM”, on page 40).

• A HiPath Customer License Agent (CLA) must be installed (cf. Section 2.3.9, 
“Installation of the CLA”, on page 43). The CLA can be installed on any 
computer in the network. Please heed the scenarios described in the 
following (cf. Section 2.3.7, “Possible Scenarios for the CLM”, on page 39).

• The licenses you have purchased must be activated via the CLM and 
transferred to the corresponding CLA. Please read the corresponding section 
in the CLM help on this. 
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2.3.6.1  The CLM Operation Mode

The CLM operation mode is comprehensively explained in the product 
documentation, which you can open via the Help button in the CLM product 
interface. Here, we only provide a short outline:

1. The CLM and the XPR server are installed

2. By means of the CLM and via the Internet you generate the required licenses 
at the Central License Server (CLS). To do this you need the authorization 
code and the MAC ID of the computer on which the CLA is installed (locking 
ID). The authorization code and the locking ID are sent by the CLM to the 
CLS.

3. With the help of the authorization code and your specific locking ID the CLS 
generates a license file and returns this file to your CLM. Thus the licenses 
are bound to the MAC ID of the computer on which the CLA has been 
installed. This affects the scenarios described further below.

4. Using the CLM the license file is transferred to the selected CLA. Based on 
the locking ID the latter checks whether the license file is valid for the XPR 
server. If the locking ID matches the one in the license file, the XPR server is 
released, otherwise the XPR server is not released.

5. The license service is installed according to Section 2.8.1, “Standard 
Upgrade”, on page 63. This service communicates with the CLA using the 
CLC. The CLC is a function library (DLL = Dynamic Link Library), which 
provides functions required for communication between the license service 
and the CLA.

6. When the XPR server starts, the installed APLs query the license service for 
an available license. Using the CLC the license service transfers this request 
to the CLA. The CLA checks whether a license is available on the specific 
XPR server for the corresponding APL and answers accordingly. After a 
successful check the APL starts and may be used.
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2.3.7  Possible Scenarios for the CLM

IMPORTANT:
When you select your scenario make sure the licenses are always bound to the 
MAC ID of the computer on which the CLA is installed and operates.

Scenario 1:

The XPR server is installed on an individual computer. CLM and CLA are installed 
on other computers in the network. This is the scenario most commonly used.

Scenario 2:

The XPR server and the CLA are installed on one computer. The CLM is installed 
on another computer in the network. In this case you need an individual license 
pack for each installed XPR server.

Scenario 3:

The XPR server, the CLM and the CLA are installed on the same computer.
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2.3.8  Installation of the CLM 

How to install the CLM: 

1. Start the setup.exe file from the 
XpressionsInstall\Prerequisites\HLM\CLM directory of the setup 
medium.

The setup is prepared and the following dialog opened:

2. Click the Next button.

Up comes this dialog:
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NOTE:
We recommend to use the preset ports and not to modify them until port conflicts 
with other applications occur. Also verify that these ports are correspondingly 
released in a firewall that may exist in the network. In case of doubt please 
contact the network administrator.

3. Click the Next button.

Up comes this dialog:

4. If you want to use the defaulted target folders, click the Next > button. 

Via the Change... button you can specify another target folder for the 
installation. After you have changed the target folder, click in this dialog on the 
Next > button.

Up comes this dialog:
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5. Click the Install button.

The installation starts and you can see the progress in the following dialog:

As soon as the installation process is complete, the following dialog appears:

6. Click the Finish button to complete the installation. 

The dialog closes and the CLM installation is complete. 

After the CLM installation you find an icon on the desktop via which you start 
the CLM. Further information about the CLM is available after the start via the 
Help button.
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2.3.9  Installation of the CLA

How to install a CLA: 

1. Start the setup.exe file from the 
XpressionsInstall\Prerequisites\HLM\CLM directory of the setup 
medium.

The setup is prepared and the following dialog opened:

2. Click the Next button. 

Up comes this dialog:
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3. If you want to use the defaulted target folders, click the Next > button. 

Via the Change... button you can specify another target folder for the 
installation. Subsequently, click the Next button in this dialog.

Up comes this dialog:

4. Select the user under whose account the CLA is to run. If you select the New 
User option, the account under which you perform the installation must have 
the corresponding privileges on the computer or in the domain. 

Click the Next button.

Up comes this dialog:
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5. If you have not changed the ports during the CLM installation, you can copy 
the settings here. Click the Next button.

NOTE: If you change the entry in the Service Port Number field you need 
to enter this modified port number with the license service installation (cf. 
Section 2.8.1, “Standard Upgrade”, on page 63, step 8 on page 67).

Up comes this dialog:

6. Click the Install button.

The installation starts and you can see the progress in the following dialog:

As soon as the installation process is complete, the following dialog appears:



Upgrading an XPR without Cluster

Upgrade.fm

Preparatory Steps

 A31003-S2370-J102-15-7631, 11/2014
46 OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation

      

7. Click the Finish button to complete the installation. 

The dialog closes and the CLA installation is complete. 

2.3.9.1  Activating a License

Activating a license means transferring the license file to a CLA so that this can 
provide the product with the necessary licenses. The procedure for activating a 
license is described in detail in the HiPath License Management operating 
manual that you may start via the Help button on the HiPath License 
Management interface. 

2.3.10  Using the Report APL with SQL Databases

2.3.10.1  Using Microsoft SQL Server 2008 Express

Microsoft SQL Server 2008 Express is a restricted version of the Microsoft SQL 
Server 2008. The Microsoft SQL Server 2008 Express used for reporting is not 
included in the OpenScape Xpressions scope of delivery and can be downloaded 
free of charge under the following URI: 

ttp://www.microsoft.com/download/en/details.aspx?id=27597

Microsoft SQL Server 2008 Express requires .NET Framework 4 Redistributable. 
.Net Framework 4 can be provided by the XPR installation or start the installation 
manually by executing the dotNetFx40_Full_x86_x64.exe file from the setup 
medium under XpressionsInstall\Prerequisites\Frameworks\NET.

The Microsoft SQL Server 2008 Express and the OpenScape Xpressions server 
can be operated on one computer in parallel. 
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Installation

The Microsoft SQL Server 2008 Express needs to be set up manually.

A database and a user must be created that are both to be deployed by the 
Report APL. Use the Management Studio Express for this purpose. 

IMPORTANT:
After the installation, remove the read and write privileges from the folder 
C:\Program Files(x86)\Microsoft SQL Server\MSSQL.1\MSSQL\Binn for the 
User group.

IMPORTANT:
Microsoft SQL Server 2008 does not recognize the data type datetime. For a 
patch see 
http://www.microsoft.com/downloads/details.aspx?FamilyId=A7C903FE-35A7-
4BB2-8E73.

IMPORTANT:
The name of the database must correspond to rules that you find on the page

http://msdn2.microsoft.com/en-us/library/ms175874.aspx

under the heading Rules for Regular Identifiers. The name must not contain 
blanks, for example. A valid name would be ReportAPLDB, but not 
Report APL-DB or Report APL DB.
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Report APL Configuration

NOTE:
You find detailed information of the Report APL configuration in chapter Report 
APL in the OpenScape Xpressions Server Administration manual.

How to use the database defined in the previous section with the Report APL:

1. Open the OpenScape Xpressions monitor and log in as administrator.

2. Open the Report APL configuration dialog.

3. Open the Database tab.

4. Select the ADO entry under Access mode and click the Configure... button.

Another dialog opens.

5. Select the Microsoft OLE DB Provider for SQL Server entry on the 
Provider tab and click the Next>> button.

The Connection tab opens.

6. Enter the following information on the Connection tab:

a) The name of the server on which the database defined above runs. You 
can make a selection from the pull-down list.

b) User name and password 

NOTE:
The data specified during the Microsoft SQL Server 2008 Express instal-
lation must be entered as user name and password. 

c) The database to be used by the Report APL

7. Click the Test Connection button to test the connection to the SQL server 
with the settings performed.

A successful connection test is indicated by a corresponding dialog and the 
Report APL configuration is thus complete. 

If the test fails, check the Report APL configuration.
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2.3.10.2  Using a Microsoft SQL Server

If the data amount exceeds 1GB, using a Microsoft SQL server is an option. This 
is only realized in the scope of a project including the Professional Services 
Organization. Over the course of the project the data amount is to be estimated 
and a corresponding scenario designed. Possible scenarios are:

• OpenScape Xpressions server and Microsoft SQL server parallel on one 
computer 

• OpenScape Xpressions server and Microsoft SQL server on an individual 
computer each

In both cases the customer needs to provide the required licenses (among others 
Microsoft SQL Server and if necessary Windows Server 2003) as well as the 
required hardware. If both servers are operated parallel on one computer, this 
computer's hardware is to be measured accordingly.

The Microsoft SQL server lets you manage very large amounts of data. Besides 
the actual SQL server the packet includes a number of management and analysis 
tools.

You can obtain Microsoft SQL server setup details from the corresponding 
product documentation or from the product homepage under http://
www.microsoft.com/sql/. Details for connecting the Report APL to the Microsoft 
SQL server are coordinated in the project scope. 

2.3.10.3  Switching from CodeBase to Microsoft SQL Server 
2005 Express or Microsoft SQL Server

When switching from CodeBase to Microsoft SQL Server 2005 Express or 
Microsoft SQL Server, available data can only be copied by installing the 
st*.log files. Prerequisite is the use of a suitable backup concept and that 
st*.log files are available. 

To perform a Backup/Restore of the databases, please read the Backup/Restore 
section in chapter Report APL of the OpenScape Xpressions Server 
Administration manual.

IMPORTANT:
When changing from CodeBase to Microsoft SQL Server 2005 Express or 
Microsoft SQL Server, available customer-specific reports cannot be used any 
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further. Default reports are available in revised version. 
Customer-specific reports must either be created by the customer or with the 
support of the Professional Service Organization.

IMPORTANT:
After the installation, remove the read and write privileges from the folder 
C:\Program Files(x86)\Microsoft SQL Server\MSSQL.1\MSSQL\Binn for the 
User group.

2.3.10.4  Changing from MSDE to Microsoft SQL Server 2005 
Express

You find information about a change from Microsoft SQL Server 2000 Desktop 
Engine (MSDE) to Microsoft SQL Server 2005 Express under 

http://www.microsoft.com/technet/prodtechnol/sql/2005/msde2sqlexpress.mspx.

In case of a change verify that the MSDE was installed by MSI setup.

XPR 7 also works with MSDE, but MSDE has be following disadvantages 
compared to Microsoft SQL Server 2005 Express:

• MSDE is no longer supported by Microsoft.

• MSDE is not operable on Windows Vista.

• MSDE databases have a maximum size of 1 GB against 4 GB with Microsoft 
SQL Server 2005 Express.

• MSDE is harder to install than Microsoft SQL Server 2005 Express.

• MSDE does not have a graphic administration tool.

• Future XPR versions may use Microsoft SQL Server 2005 Express features 
that MSDE does not offer.

2.3.11  Installed Components

Owing to far-reaching modifications the setup of the new version cannot 
automatically determine, which components have already been installed. For this 
reason, the components already installed must be manually determined and 
noted down. Proceed as follows:

1. Open the operating system's software management via Start > Control 
Panel > Add or Remove Programs. 

2. Make a list of the components itemized there:
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• Communications

• Xpressions Server or MRS Server

• Exchange SnapIns for MMC

• ACD Agent

• ACD Supervisor

• Crystal Report Viewer 

The Crystal Report Viewer requires a Crystal Reports XI Developer 
Edition.

• Application Generator 

In XPR 6 R0 the Application Generator has been replaced with the 
Application Builder.

• EVO 

• CallerGuide 

• Installed language packets 

During the upgrade, you need to manually select such components for 
updating them as well. Please note that all components concerning the 
contact center functionality are no longer included in the scope of delivery. 
Both, the ACD Agent and the ACD Supervisor have consequently been 
dropped.

3. Check whether ISDN cards are installed in the system, and if so, which ones. 
Open the device manager via Start > Control Panel > System > Hardware 
tab > Device Manager. Next, open the Network adapters entry and check 
whether entries named Dialogic/Eicon Diva Server are available.
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2.3.12  Automatic Speech Recognition (ASR)

Owing to a restriction in the Openspeech 3.0 software an existing Openspeech 
version cannot be automatically upgraded. 

If automatic speech recognition is installed, for example, for CallerGuide or EVO, 
the existing Openspeech version must first be uninstalled. Not until then can the 
new version Openspeech 3.0 be installed.

NOTE: The uninstallation of Openspeech Recognizer 2.0 requires a system 
reboot.

NOTE: TTS and ASR have been released only for specific operating systems 
(see the service documentation OpenScape Xpressions Release Notice). 

How to uninstall Openspeech:

1. Open the Windows software manager via Start -> Settings -> Control Panel 
-> Add or Remove Programs.

2. Select the Openspeech Recognizer 2.0 entry in the list and click on Remove. 

3. Answer the security prompt with Yes.

The uninstallation starts.

4. Answer the system reboot prompt with Yes.

After the reboot, uninstalling Openspeech Recognizer 2.0 is complete.

2.3.13  Function CTI Journal 

The CTI Journal switch in the Web Assistant and in Communications activates 
the CIP journal for a user as of HiPath Xpressions 4.0SA10 or MRS 6.01. As of 
version OpenScape Xpressions 6 or MRS 8.0 this switch activates the entire CTI 
functionality for a user.

2.3.14  LDAP APL

The functionality of the LdapS APL available in the previous version has been 
completely integrated in the Ldap APL. The LdapS APL is not available any more.

Information about the migration from the LdapS APL to the Ldap APL is currently 
provided in a separate service info in the g-DMS (INF-07-000391).



Upgrade.fm

Upgrading an XPR without Cluster

Preparatory Steps

A31003-S2370-J102-15-7631, 11/2014
OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation 53

       

2.3.15  TCP/IP APL

The feature Name Reverse Resolving (Revolving an IP address into a domain 
name) is not available any longer.

2.3.16  Web APL

In case of an update, customer-specific settings in configuration files are 
prevented from being overridden as two configuration files are available, e.g.:

• <file name>_default.xml

• <file name>.xml

The contents of the configuration files is identical at the initial installation. The 
customer performs his/her individual changes exclusively in the <file 
name>.xml file. The <file name>_default.xml file remains unaffected.

The respective component reads out the customer-specific file with the 
customized contents first. Then the default file is read out. The parameters 
already read out in the customer-specific file are ignored when the default file is 
read out.

IMPORTANT:
The <file name>_default.xml file must not be removed because system 
errors occur otherwise. 

2.3.17  Migration of Exchange Server 2003 to 
Exchange Server 2007

How to migrate an XPR server from an existing connection to Exchange Server 
2003 to a connection to Exchange Server 2007:

• Uninstall the existing connector (E2kApl). Use the Modify option from the 
XPR server setup for this purpose.

• Then install the new XPR Foreign Connector (E7kApl). When installing the 
connector, establish a connection to the server that is to adopt the "Hub 
Transport Server Role".

• Keep in mind that after the new installation of the XPR Foreign Connector the 
mailbox replication feature in not supported anymore. Users who used to 
access the Exchange mailbox via this feature must be reset to True Unified 
Messaging (TUM).
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2.3.18  BIRT as Alternative to Crystal Reports

The scheduler for the report module creates and sends statistical reports in 
different formats. This module assumes an installed report module and either an 
installed Crystal Reports XI Developer Edition or BIRT (Business Intelligence and 
Reporting Tool).

The BIRT runtime component is on the XPR setup medium and installed in the 
<XPR_Install>/ReportEngine directory during the ReportScheduleApl setup. 

BIRT can be downloaded from http://www.eclipse.org/birt free of charge. 

BIRT requires the Sun-Java runtime environment version 6 or higher. BIRT does 
not work with an older version or with an JVM by another producer. The JRE must 
be installed on the computer that also hosts the ReportSchedule APL. The JVM 
is neither shipped nor installed with the XPR. You can download it from http:/
/java.sun.com free of charge.

BIRT requires the installed Microsoft SQL Server 2005 JDBC driver. This driver 
is neither shipped nor set up with the XPR. You can download it from http://
msdn.microsoft.com/en-us/data/aa937724.aspx free of charge. Extract the 
sqljdbc.jar file from the downloaded file and copy it to the directory 
<XPR_Install>/ReportEngine/ plugins/ 
org.eclipse.birt.report.data.oda.jdbc_2.2.0.v20070615/
drivers. 

Layout files of Crystal Reports (RPT files) and of BIRT (RPTDESIGN files) are not 
compatible.

BIRT provides the export formats PDF and HTML. We recommend PDF exports. 
BIRT reports are available in German, English and French only.

To modify BIRT layout files you need to download the BIRT report designer 
component under consideration of the matching eclipse components and 
versions from www.eclipse.org/birt free of charge and install it in the 
<XPR_Install>/ReportEngine directory.

2.3.19  Configuring the Web Conference Server

IMPORTANT: The web conference server must be configured prior to 
completing the upgrade! A retrospective configuration may lead to an 
erroneous behavior of the web conference server. 
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1. Open the settings.ini file in the setup folder of the web conference 
server in an editor. This is path 
C:\Program Files(x86)\WebConferenceServer by default. 

2. Look for the following line:

ExternalAddress=Change2YourServer

3. Replace value Change2YourServer with the external, fully qualified 
domain name (FQDN) of the web conference server computer. 

NOTE: The external FQDN is the full outward name of the web conference 
server computer. The internal FQDN is the full name of this computer seen 
from the internal company network. If only a single FQDN is available, use it.

4. Save the modifications.

Assigning a permanent IP

The system must have two IP addresses. One of them is used by the web 
conference server and the other one by the WebAPL. A permanent IP must be 
assigned to the web conference server for this purpose.

5. Open the XPR monitor under Start >Programs> Xpressions>.

6. Select in the dialog Modules of> Preferences> WebApl.

7. Doubleclick Edit Settings. 

The Web APL Configurations dialog opens. The HTTP tab indicates the 
Web Apl IP address used.

8. Open the command prompt and enter the ipconfig command.

IMPORTANT: Enter this command exactly as described. Heed upper and 
lower case, inverted commas and blanks.



Upgrading an XPR without Cluster

Upgrade.fm

Preparatory Steps

 A31003-S2370-J102-15-7631, 11/2014
56 OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation

      

The available IP addresses are listed. Note down the IP address not used by 
the WebAPL, since it is assigned to the web conference server.

9. Enter the command cd “\Program files(86)” in the command prompt.

10. Enter the command cd WebConferenceServer in the command prompt.

IMPORTANT: If you use the httpcfg tool, do not assign port information to the IP 
address. 
You can query the already present settings with the 
httpcfg query iplisten command. If the configuration has more than one 
port entry, the web conference server starts imperfectly.

11. Enter the command httpcfg set iplisten -i <IP for the web 
conference server> in the command prompt.

12. Enter the command httpcfg set iplisten -i 127.0.0.1 in the 
command prompt.

The configuration is complete. 

2.3.20  Uninstalling unsupported Components

The following components are no longer supported and must be uninstalled 
before an upgrade.

• MMCC (Multimedia Contact Center)

• SAPbyDesign

You must not include these features in an upgrade to XPR V7. They must be 
uninstalled. 

All information about these features in other XPR V7 documentation is obsolete.

2.3.20.1  Uninstalling MMCC (Multimedia Contact Center) 

1. Insert the XPR/MRS setup medium of the system to be upgraded in the 
computer.

2. Start the Setup.exe and select Modify.

3. Follow the instructions on the screen until the Select components window 
appears.

4. Disable the ACD Supervisor check box
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5. Follow the instructions on the screen until the Select Features window 
appears.

6. Disable the ACD/Call Center check box.

7. Click the Next button.

When the installation continues, all features deactivated by you will be 
uninstalled.
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2.4  Updating the XPR Server Software and Client Components

2.4.1  Installation Basics

NOTE: The specifications in this section do not apply for a silent upgrade (see 
Section 2.8.2, “Silent Upgrade”, on page 84).

Because the XPR system consists of several components, the installation of the 
product is realized as a so-called Component Installer.

This installation mode starts with the selection of all product components to be 
installed. In the second step, the setup programs of the selected components are 
called and executed one after another.

During the whole setup program a dialog is displayed for a better overview, 
showing you where exactly in the Component Installer you are.

IMPORTANT: The computer may only be restarted when the Component 
Installer asks you to via the following dialog:
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2.4.2  Mixed Operation with several Versions

If several XPR servers exist in the same organization and one of them is to be 
upgraded from version 5.0 Rx to version V7 R1, definitely execute the following 
steps in the sequence given here:

1. Publish the ServerBasedForms of the new version V7 R1 in the public form 
folder Organization Forms of the Exchange server that the XPR server to be 
upgraded connects to. Please read the corresponding chapter in the 
OpenScape Xpressions Exchange Gateway manual on this.

NOTE: If several Exchange servers connected to XPR servers to be 
upgraded are operated in the organization, the ServerBasedForms must be 
published on each of these Exchange servers.

2. Upgrade the relevant XPR server to V7 R1 according to the instructions in 
Section 2.8.1, “Standard Upgrade”, on page 63.

IMPORTANT: In step 52 on page 81 definitely verify that the option Start 
OpenScape Xpressions in the following dialog is NOT enabled.

3. Reboot the XPR server manually.

4. Update the Outlook components (ServerBasedFormsClientComponents) on 
the user computers that collaborate with an XPR server of version V7 R1. 

User computers that still collaborate with an XPR server of version 4.0SA10 
may continue using the old forms. Please read the corresponding chapter in 
the OpenScape Xpressions Server Installation manual on this. 
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2.5  Upgrading the Outlook Client Components

The Outlook client components of the version used under XPR 4.0SA10 cannot 
be upgraded to the current version. This comprises the following components:

• Local SMTP forms

• Server-based forms

• Server-based client components

So that the new version can be used, the old one must first be uninstalled. 

Proceed as follows:

1. Open the software management via Start > Control Panel > Add or 
Remove Programs.

2. Find the corresponding entry in the list.

3. Select this entry and click on Change/Remove. The uninstallation is 
performed fully automatically.

4. Install the new version. You find the setup files on the setup medium in the 
following directory:

Start the setup.exe file in the corresponding subdirectory. 

5. Click Continue.

6. Specify the Web Assistant address. Then click Next.

7. Click Install.

8. Perform the steps 1 to 7 on each client computer.

2.6  Upgrading the optiClient 130

During the optiClient 130 setup, registry keys are automatically created. In case 
of an upgrade, these keys are then automatically reset to their default value. Keys 
manually created for optiClient 130 will not be reset during an upgrade. Please 
refer to the administrator documentation and operating instructions OpenScape 
Xpressions optiClient 130 to learn which keys are manually created.

XpressionsInstall\AddOn\Client\Exchange\Forms\ServerBasedForms
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2.7  Connecting the CTI APL to a HiPath 4000

In the new version, the connection of the CTI APL to a HiPath 4000 is enabled via 
the CA4000 connector. Therefore, the scenario used with XPR 4.0SA10 and a 
CAP server is no longer applied and the CAP server no longer required.

The installation and configuration of the CTI APL connection to a HiPath 4000 is 
comprehensively described in the OpenScape Xpressions Server Administration 
manual.



Upgrading an XPR without Cluster

Upgrade.fm

Upgrading XPR V6 64-bit to XPR V7

 A31003-S2370-J102-15-7631, 11/2014
62 OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation

      

2.8  Upgrading XPR V6 64-bit to XPR V7

The major steps of upgrading XPR V6 installed on a 64-bit operating system to 
XPR V7 consist of executing a Setup.exe file and selecting the Repair radio 
button in a dialog. This procedure is described in Section 2.8.1, “Standard 
Upgrade”, on page 63.

Alternatively, you can upgrade XPR V6 without user interaction under specific 
restrictions. This is described in Section 2.8.2, “Silent Upgrade”, on page 84.

If an XPR installed on a 32-bit operating system or an MRS is upgraded, 
upgrading must occur mandatorily by the following major steps:

1. Data backup of the old XPR/MRS installation

2. Reinstallation of XPR V7

3. Data restore on the XPR V7 installation

This procedure is described in the following sections:

• Section 2.10, “Upgrading from XPR V5 to XPR V7”, on page 94

• Section 2.9, “Upgrading from XPR V6 32-bit to XPR V7”, on page 87

• Section 2.11, “Upgrading from MRS 8.03 to XPR V7”, on page 103
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2.8.1  Standard Upgrade

NOTE: The silent upgrade (see Section 2.8.2, “Silent Upgrade”, on page 84), 
which does without user interaction, is an alternative to the standard upgrade 
under specific restrictions.

IMPORTANT: Before performing the upgrade, please make sure that a 
HiPath License Management exists within the network and that a Customer 
License Agent with the necessary licenses is available. Please also read 
Section 2.3.6, “Installation of the License Management and License 
Service”, on page 37.

IMPORTANT: If you perform an installation via a remote desktop connection and 
you wish to install Text-To-Speech (TTS) (see step 21 on page 72), do not use 
Start > Programs > Accessories > Communication > Remote Desktop 
Connection, because setting up the XPR cannot be correctly finished then. 
Instead, start the remote desktop connection by entering the command 
mstsc /v:<IP address> /console 
or 
mstsc /v:<IP address> /admin
in a command prompt. Use the admin parameter with Windows XP Professional 
as of SP3, Windows Vista as of SP1, Windows 7 and Windows Server 2008 and 
use the console parameter with all other operating systems. In this case <IP 
address> is the IP address of the computer on which the XPR is to be upgraded. 
Insert the XPR setup medium in the computer or connect the shares of the remote 
desktop client to a drive letter.
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To update the XPR server software you must perform the following steps:

1. Check whether you may upgrade from the available XPR version (see 
Section 2.1, “Upgrade Versions”, on page 13).

2. If UCC components are installed, execute the following sub-steps:

a) Change the privileges of the SQL FastViewer service user account to a 
user account that has privileges of the XPR service.

b) Perform the following queries on the Postgres database user interface:

3. Stop the XPR server via Start > Programs > Xpressions > Stop Server.

4. Insert the setup medium of OpenScape Xpressions V7 R1 in the server 
computer. If the autorun mode is on, the Component Installer starts 
automatically.

NOTE: If you have disabled the autostart mode for the setup medium, 
execute the Setup.exe program in the XpressionsInstall directory of 
the setup medium to install XPR on your computer. To do this, select the Run 
command in the Windows Start menu. Then enter 
x:\XpressionsInstall\Setup in the Open: text field, with X being the 
drive letter of your setup medium or of the connected network drive. Confirm 
your input with OK. 

The installation starts with a welcome screen. Then commences the license 
server installation.

5. If a license service is installed on the computer, the following window opens:

Click the Yes button to upgrade the license service. Click the No button to 
skip upgrading the license service. If you click the Yes button, the following 
dialog opens:

UPDATE symVCC.symConferenceUserTempl SET InvitationAddress = lower(InvitationAddress);
UPDATE symConferencing.Invitees SET InvitationAddress = lower(InvitationAddress);
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Maintain the default set option and click on Next. 

NOTE: If you select Repair, all APLs already installed will be upgraded, if the 
licenses for the APLs are available. So, if the IP APL as well as the ISDN APL 
are installed, both APLs are upgraded in one upgrade process. Please also 
heed the notes for the IP APL.

The license service upgrade process starts.

The license service upgrade process finishes with the following window:
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The XPR server upgrade is continued with step 11 on page 69.

If no license service has been installed on the computer, the license service 
setup starts automatically.

6. Click Next. 

Up comes this dialog:
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7. Accept the defaulted target path for the installation or click the Change button 
to specify another installation target path. Then click Next. 

NOTE: We recommend to copy the default.

8. In the IP address field specify the IP address of the computer on which the 
CLA runs. Click the Next button. The time-out in the Time-out field is 
specified in milliseconds.
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9. Click the Install button. 

The license service installation starts. The installation progress is displayed 
in the following dialog:

After the copying process has been completed, the following dialog opens:
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10. Click on the Finish button. 

Up comes this dialog:

11. Click Yes. Up comes this dialog:

12. The available languages are already preselected. In the Active column select 
the languages to be additionally installed. Only select as many languages as 
licenses are available.

NOTE: You need to select at least one language, otherwise you cannot 
continue the upgrade.



Upgrading an XPR without Cluster

Upgrade.fm

Upgrading XPR V6 64-bit to XPR V7

 A31003-S2370-J102-15-7631, 11/2014
70 OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation

      

13. If required, change the language the server is to use as default in the Default 
language column. 

14. Click the Next button. Up comes this dialog:

This dialog represents the ReleaseNotes.rtf, which is found in the 
XpressionsInstall directory of the setup medium. 

15. Please read the Release Notes. Via the Open in external viewer button you 
can open the corresponding file in the application that is registered in the 
operating system for the file type RTF. 

16. Select the I have read the Release Notes checkbox. This activates the Next 
> button.

If you do not select the checkbox, the Next > button stays inactive and you 
cannot continue the upgrade. 

17. After you have read the Release Notes, click the Next > button. Up comes 
this dialog:
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Language packets that you have already selected in step 12 are indicated in 
this dialog. The checkbox that you have activated for the default language 
there is displayed here in gray and cannot be deselected. 

18. Select the components to be installed. 

Here you must always select the XPR server component to update the 
XPR server software. 

In the Administration section select the administrative client applications 
(such as Communications) for updating.

19. Click the Next button. Up comes this dialog: 
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20. Select the components that are already installed on the system and that you 
have noted down in Section 2.3.11, “Installed Components”, on page 50. 

NOTE: Please note that the Application Generator has been replaced with 
the Application Builder in XPR V6. 

NOTE: If the behavior of the Application Builder is incorrect after the instal-
lation, replace in the registry under HKLM\SOFTWARE\PP-
COM\XPR\MTA\File Systems value
/USERDATA;//<computer name>/MRSUSERDATA$ with value
/userdata;//<computer name>/MrsUserdata$.

Then click Next. Up comes this dialog: 

21. Select here the driver to be updated. You find more detailed information about 
the driver versions in the OpenScape Xpressions Server Installation manual. 

NOTE: Nuance Vocalizer requires a corresponding text-to-speech license 
for the XPR server as well as a Nuance Vocalizer license.

NOTE: If you have selected Repair in step 4 on page 64, all APLs already 
installed will be upgraded, if the licenses for the APLs are available. So, if the 
IP APL as well as the ISDN APL are installed, both APLs are upgraded in one 
upgrade process.

Then click Next. Up comes this dialog:
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22. The viewer software is version 9 of the Adobe Acrobat Reader. If there is an 
older version on the system, you can upgrade this version now. 

23. If you have a license for Automatic Speech Recognition (ASR), the dialog 
features the Next button instead of Install >. Click on Next > to open the 
dialog for determining the installation type for ASR. Up comes this dialog:

24. Select in the ASR Installation Type section the installation type with which 
ASR is already installed. In the Select Application section choose Evo and/
or CallerGuide for installation. 

If you have not selected a driver for communication hardware, please 
continue with 34 on page 76.

25. The selection of the components to be updated is now complete. Click on 
Install to start the setup programs of the selected components in succession.

26. The driver update of an Dialogic/Eicon ISDN board starts with a welcome 
dialog. Up comes this dialog: 
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27. Click on Next to start the driver update.

IMPORTANT: At times, Dialogic uses different version numbers for the same 
board. For example, the hardware description features a specific version 
number for a board, but in the Dialogic Diva Configuration Manager you find 
another version number for the same board. The version numbers used for 
Dialogic ISDN boards in this XPR V7 R1 guide are always the version 
numbers specified in the Dialogic Diva Configuration Manager!

NOTE: During the driver update the current settings for the Dialogic/Eicon 
ISDN boards are inherited.

NOTE: Please note the list of supported Dialogic/Eicon ISDN boards in 
Section 2.3.3.1, “Dialogic/Eicon ISDN Boards”, on page 28.

28. The new driver files are now copied to the system.

29. After the successful update, the following dialog opens:

30. Verify that the Restart your computer option is deactivated. Then click 
Finish to complete the procedure. 

The Diva Configuration Manager starts:
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31. Check whether the configuration of the Dialogic/Eicon board used so far is 
correct. If yes, close the program via the menu option File > Exit. If you are 
then prompted to restart the computer, click on No.

If you want to perform modifications to the configuration, you can do so at this 
point. Activate your modifications via the menu option File > Activate and 
close the configuration program. In the upcoming prompt to restart the 
computer click on No.

The Component Installer now displays the following dialog with a restart 
prompt:

32. Confirm this prompt with Reboot system.

33. After you have rebooted the computer, the Component Installer is 
automatically continued and the following dialog opens: 
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34. Select the Repair option. This option first upgrades all components of 
OpenScape Xpressions V6 R2 to the current version OpenScape 
Xpressions V7 R1.

If you want to install further OpenScape Xpressions V7 R1 features, perform 
the setup program after the update once more and select Modify. Click the 
Next button to continue. 

If the Report APL is installed, the following dialog opens:

35. Click on Yes if you have backed up the reports (cf. Section 2.3.2.2, “Backing 
up Reports”, on page 26), or if backing up the reports is not necessary 
because they have not been changed. Up comes this dialog:

36. Click Yes. The XPR server is being upgraded and the required data copied. 
The progress is displayed via a status dialog. After the copying process has 
been completed, the following dialog opens:
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37. In the Phone number dialing rules for country field select the country for 
which you want to perform the connection settings.

NOTE: If the respective country is not listed, select a country that corre-
sponds to the desired connection settings or choose the General option.

38. In the other dialog fields check the connection settings of your system for 
correction. If entries are incorrect, perform the necessary modifications here.

39. Click the Advanced... button. The following dialog opens: 

Field/Button Description

Country Select your country from this list to define the international 
country code.

Area code (without 
prefix)

Enter here the area code without prefix. In Germany this is 
thus the area code without the leading 0, in the US the area 
code without the leading 1.
Example: 2404 from +49-2404-901-195

Subscriber code Enter here the subscriber code of a phone number. 
Example: 901 from +49-2404-901-195
In US this is called Office Code.

International prefix Specify here the international prefix. In the US this is 011, in 
Germany 00. 

National prefix Enter here the prefix that is part of your area code. In 
Germany this is the leading zero of the area code, in the US 
this is the 1.

External prefix Enter here the external prefix.
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40. Answer the question whether existing NCO rules are to be replaced or 
maintained as follows:

• Select NO if you have modified the NCO rules on the XPR server or 
added new ones that may get lost. Only new rules missing in the XPR 
server and required by an APL or a client will be copied then. New rules 
are stored in the <XPR Install>\res\NCO directory and can be imported 
from there in the existing rule set by means of the NCO admin tool.

• Select Yes if you want to replace the rules available on the XPR server 
with the new rules from the setup medium. Rules probably modified will 
then be irretrievably lost. 

The Number Conversion administration dialog opens with a list of all 
locations:

41. Open the Locations tab. 

42. Doubleclick the location entry that you want to edit. The Location editor 
opens: 
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43. Check and configure the correct range codes for the locations. If several 
subscriber codes are available, the SubscriberCode entry must be deleted. 
Use RangeCode instead to subsequently specify the subscriber codes with 
the corresponding DID-ranges. How to specify a RangeCode: 

a) Click the Location codes field with the right mousebutton and select the 
Add entry in the context menu. Then select the RangeCode entry. 

b) A dialog opens for you to enter the data to the new RangeCode. 

c) Click the OK button to save the RangeCode settings. 

44. In the Location editor click the OK button. You are taken back to the Number 
Conversion administration dialog.

45. Perform step 43 on page 79 and 44 on page 79 for all available locations.

46. In the Number Conversion administration dialog click on OK and answer 
the question whether the configuration modifications should be saved with 
Yes. You are taken back to the Regional Settings dialog. 

47. Check the settings in this dialog and click the Next button. 

48. The upgrade continues and the dialog that features further IP addresses for 
web conferences is shown.
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49. If you want to add further addresses to those already specified with the initial 
installation, do so and click on Next.

50. Upgrading is continued and a progress dialog displayed. 

51. Upgrading is continued and the selected language packets and client 
programs installed. The language packets are installed fully automatically.

IMPORTANT: Please note that manual configurations of the web conference 
server are required before the upgrade to gurarantee smooth operation after 
the setup! The detailed description of this process is contained in chapter 
Section 2.3.19, “Configuring the Web Conference Server”, on page 54

Some client programs (like e. g. Communications and Application Builder) 
require a manual intervention during their setup. Proceed as follows: 

a) Example Communications:

1. In the welcome dialog click Next.

2. Activate the Update existing installation (recommended) option 
and click on Next.

3. The available client program installation is being updated.

4. Click Finish. 

b) Example Application Builder:

1. In the welcome dialog click Next.

2. Specify the destination folder for the Application Builder and click on 
Next.

3. Select a language for the Application Builder and click on Next.
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4. Click the Next button.

5. Click Finish. 

Perform these substeps for all further client programs to be updated.

After the installation of the voice packets and client programs, the following 
dialog opens:

52. For upgrades from a version lower then V7 R1 we recommend to execute the 
CompactDB tool to reduce the database size.

If want to do so, execute the following substeps:

NOTE: You can reduce the database size later at any time when XPR is not 
in operation.

a) Read the prerequisites in the “CompactDB” section of the administrator 
documentation OpenScape Xpressions Server Administration.

b) If the prerequisites apply, deactivate the Reboot system checkbox.

c) Click the OK button.

d) Execute the instructions in the “CompactDB” section of the administrator 
documentation OpenScape Xpressions Server Administration.

e) Reboot the computer.

If you do not want to reduce the database size, verify that the Reboot system 
checkbox is active, click the OK button. The computer reboots.

53. After rebooting the computer, you can install the Smart Services Delivery 
Platform (SSDP). To do this, double-click the
XpressionsInstall\AddOn\Misc\SSDP\ssdp.exe file on the XPR 
setup medium and follow the instructions. Please obtain further information 
from the PDF document SSDP CopSSH Installation Guide in this 
directory.

54. Execute the following substeps to synchronize the Connection APL database.

a) Start the XPR monitor. 

b) In the Modules dialog open the Connection APL configuration dialog by 
doubleclicking Con APL > Edit Settings.
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c) Click on the Properties button next to the Database checkbox.

d) Click on the Synchronization tab.

e) Click on the Sync now button.

f) Click the OK button.

g) Click the OK button.

55. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:

a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.
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56. If the XPR is integrated with a ComAssistant, the following assignments must 
have been entered in the 
<Inst_Path>\config\common\Xpressions.cfg file on the computer 
that hosts the ComAssistant:

Xpressions.remotePort=10000 
Xpressions.localPort=10001

57. Install the following hotfixes: 

• Mta-810-15217 (or later) 

• Ucc-810-15276 (or later).

58. You must set the registry value DisableUserTOSSetting under HKLM/
SYSTEM/CurrentControlSet/Services/Tcpip/Parameters to 0 for 
the QoS settings of the IP APL to be used for communication.
In most Windows versions this registry value is not configured by default. In 
this case you need to manually add it as REG_DWORD as described in the 
respective passage. Furthermore, the computer system needs to be rebooted 
for the registry modification to take effect. If the IP APL cannot find this 
registry value with the entry 0, a corresponding error message is issued in the 
XPR monitor during the IP APL start.

Upgrading is now complete.
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2.8.2  Silent Upgrade

Silent upgrade does without user interaction and is an alternative to the standard 
upgrade (see Section 2.8.1, “Standard Upgrade”, on page 63). Silent upgrade 
does not include any feature modifications, i. e. it corresponds to a normal 
upgrade initiated using the Repair radio button.

Restrictions

You can automatically upgrade to XPR V7 R1 FR1 from XPR V6 R2 64-bit, 
XPR V7 R0 64-bit and XPR V7 R1 64-bit only. 

The silent upgrade of UCC components such as Web Collaboration Server, 
Connection APL, Media Server and conferencing modules on satellite computers 
is not supported.

How to proceed

IMPORTANT: Before performing the upgrade, please make sure that a 
HiPath License Management exists within the network and that a Customer 
License Agent with the necessary licenses is available. Please also read 
Section 2.3.6, “Installation of the License Management and License 
Service”, on page 37.

To update the XPR server software you must perform the following steps:

1. Stop the XPR server via Start > Programs > Xpressions > Stop Server.

2. Stop XPR clients such as Communications or XPR Monitor.

3. Insert the setup medium of OpenScape Xpressions V7 R1 in the server 
computer. 

If the autorun mode is on, the Component Installer starts automatically. 
Cancel the component installation program.

4. Click on Start in the taskbar.

5. Click Run.... A dialog opens.

6. Enter cmd in the entry field. 

7. Click OK. A command prompt opens.

8. Enter the following command in the command prompt:

x:

x represents the letter of the drive on which the XPR server setup directory is 
found.

9. Enter the following command:

cd <XPR_Install>\
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<XPR_Install> represents the installation directory of the XPR server.

10. If you upgrade from XPR V6 R2 64-bit, enter the following command:

setup.exe --silent-repair --new-hlm:<IP address>

<IP address> represents the IP address of the HiPath license 
management of this XPR.

11. If you upgrade from XPR V7 R0 64-bit or XPR V7 R1 64-bit, enter the 
following command:

setup.exe --silent-repair

12. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:
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a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.

13. For upgrades from a version lower then V7 R1 we recommend to execute the 
CompactDB tool to reduce the database size by following the instructions in 
the “CompactDB” section of the administrator documentation OpenScape 
Xpressions Server Administration.

NOTE: You can reduce the database size later at any time when XPR is not 
in operation.
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2.9  Upgrading from XPR V6 32-bit to XPR V7

NOTE: You can upgrade to OpenScape Xpressions V7 from versions XPR 
V6R2.x only. Please obtain further information from the table in Section 2.1, 
“Upgrade Versions”, on page 13.

IMPORTANT: The Smart Backup & Restore feature assumes that the user 
assigned to the MTA service is also the installing one.

IMPORTANT: If you have installed the Connection APL on a satellite system, 
back up the configuration data manually.

Upgrading from XPR V6 32-bit to XPR V7 comprises the following major steps:

1. Data backup of the old XPR V5 installation

2. Reinstallation of XPR V7

3. Data restore on the XPR V7 installation

These major steps are detailed in the following sub-sections.

2.9.1  Data Backup on XPR V6 32-bit

1. Install the latest hotfixes on the XPR V6 32-bit. A table in section Upgrade/
Update in the Release Notes lists the hotfixes according to the versions.

The following hotfixes must be installed:

• Ucc-803-14924

• WebApl-803-14511

• WebAssistant-803-14511

• ConApl-803-15063

• Mta-803-15218

• CycosOpenSSL-803-20120119
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2. If UCC components are installed, execute the following sub-steps:

a) Change the privileges of the SQL FastViewer service user account to a 
user account that has privileges of the XPR service.

b) Perform the following queries on the Postgres database user interface:

3. Start the Web Assistant and log on as administrator. In the navigator, click on 
Server settings and then on Smart backup and restore. The Smart 
Backup and Restore dialog opens.

IMPORTANT: The Smart Backup and Restore feature assumes the user 
assigned to the MTA service also to be the installing user.

4. Additionally, tick off the TOV7 check box in the options list.

5. Check which of the following check boxes you must activate:

• NCO backs up the configuration settings of the Number Conversion 
Object. The NCO configuration files NcoMainTree.xml and 
VariableProposals.xml are backed up. All other files available in the 
<XPR Install>\NCO directory are dynamically created at runtime.

• REGISTRY backs up the entries of the XPR server in the registry. The 
HKLM\Software\PP-COM\MRS section in the registry of the kernel 
computer is backed up in the regexp_serverconf.reg file.

• INFOSTOR backs up the data of the XPR server database. User and 
system data (Correlation database) and the database with the message 
headers (Journal database) are completely exported to the 
fullexp.exp file.

• FOLDERS backs up the data of the message store. A complete copy of 
the directories is created under the share MrsFolders$. This includes 
all messages on the system.

• USERDATA backs up the user-created configurations. A complete copy 
of the directories is created under the share MrsUserData$. This 
includes for example private greetings of the users.

• ISC backs up the configuration settings for a possibly configured system 
networking. A complete copy of the directories is created beneath <XPR 
Install>\ISC for this purpose. The configuration data for the system 
networking is stored there.

UPDATE symVCC.symConferenceUserTempl SET InvitationAddress = lower(InvitationAddress);
UPDATE symConferencing.Invitees SET InvitationAddress = lower(InvitationAddress);
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• UCC backs up the data of the PostgreSQL database. The PostgreSQL 
database mrsdb is written in the dump.sql file. Furthermore, the 
following files from the <XPR Install>/UCC/application_host/ 
directory are backed up:

– applets/conference/ConferencingApplication.xml
– binders/terminal/bindings/conference.xml
– providers/sip-connectivity/sip-connectivity.xml
– providers/streaming-mps/streaming-mps.xml

The following files are backed up in addition:

<XPR_Install>/cyPHONEWeb/config/*.*
<XPR_Install>/cyPHONEWeb/.keystore
<XPR_Install>/UCC/common/conf/instance_8dff7acb-6780-4b7d-
9089-e2684fc8b326-localhost.xml 
C:\Program Files\webconferenceserver\settings.ini

• SATELLITE backs up the configuration files of a satellite installation. The 
registry section HKLM\Software\PP-COM\MRS of the satellite 
computers is backed up in the <name of the satellite>.reg files.

6. The Backup Path field is allocated with value <XPR_Install>. Change this 
value is required.

7. Click on Backup now. The backup file is created. It will be used in step 5 on 
page 92 for restore.

NOTE: If the MTA does not operate under a user account, the backup is 
written in the c:\windows\temp directory, otherwise in the temp directory 
of the corresponding user account.  The backup file is a TAR file.

8. If you have installed the Connection APL on a satellite computer, back up the 
configuration data manually.
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2.9.2  Installing the XPR V7 Server

1. Install the XPR V7 server. In doing so please heed the following points:

• Keep the XPR server's name. 

• When performing the installation, deploy for user PGROOT of the 
PostgreSQL database the same password you used when setting up the 
old V5 system. Keep the server name. 

• For systems integrated in Exchange you need to install the ldap, exchapl 
and exumapl; the configuration may occur at a later date. 

• The Web Assistant is used for restore, so you need to configure the 
WebApl now. 

2. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:



Upgrade.fm

Upgrading an XPR without Cluster

Upgrading from XPR V6 32-bit to XPR V7

A31003-S2370-J102-15-7631, 11/2014
OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation 91

       

a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.

3. Install the latest hotfixes on the XPR V7 server before starting the restore.

IMPORTANT: The restore assumes all installation and data directories to 
have the same name. The restoration of new installation directories is not 
supported. 

Check that the following hotfixes have been installed:

• The highest MTA hotfix

• The highest UCC hotfix

• For an XPR V7 server integrated in a Microsoft Exchange 2007/2010 
server: E2k7AplInstaller-810-15204

4. If the Web Conference server is installed on the same computer as the XPR 
V7 server, perform the configuration for the Web Conference server. Please 
read section Configuring the Web Conference Server in the OpenScape 
Xpressions Server Installation manual on this.
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2.9.3  Restore on the XPR V7 Server

Restore

1. If you have installed UCC components, stop the Connection APL service 
(ConApl).

2. If you have installed UCC components, start the Postgres service.

3. Start the Web Assistant.

4. In the navigator, click on Server settings and then on Smart backup and 
restore. The Smart Backup and Restore dialog opens.

5. Access the Files to restore combo box to select the backup file you created 
in step 7 on page 89 on the XPR V6 computer.

6. Click on Restore.

7. If you have installed UCC components, stop the Postgres service.

8. Open a Microsoft command prompt and execute the renservr command for 
every modified IP address.

renserv OLD_IP NEW_IP

9. Execute the renservr command for every modified computer name.

renserv OLD_MACHINE_NAME NEW_MACHINE_NAME

10. Stop the XPR V7 server. 

Additional Instructions

11. Correct the DNS entries of your XPP server on the DNS server.

12. If the XPR V7 is integrated in a Microsoft Exchange 2007/2010 server, 
deactivate the connector of the XPR V6 in the Exchange server. Execute the 
following command in the Exchange Management Shell to receive the name 
of the Exchange connector: 

Get-ForeignConnector | fl

Enter the following command to disable the Exchange connector:

Set-ForeignConnector -Enabled $false

Activating the XPR V7

1. Stop the XPR V6 32-bit.

2. Start the XPR V7. 

3. For systems integrated in Exchange 2007/2010 you need to execute the 
following commands:

• <XPR_Install>\bin\ExchAplConfigurator.exe and follow the 
configuration steps.
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• <XPR_Install>\bin\E2K7Apl.exe install

• <XPR_Install>\bin\E2KApl.exe register

• <XPR_Install>\bin\ExUmApl.exe install

• <XPR_Install>\bin\ExUmApl.exe register

4. For systems integrated in Exchange 2003 you need to execute the following 
commands:

• <XPR_Install>\bin\ExchAplConfigurator.exe and follow the 
configuration steps.

• <XPR_Install>\bin\E2KApl.exe install

• <XPR_Install>\bin\E2KApl.exe register

• <XPR_Install>\bin\ExUmApl.exe install

• <XPR_Install>\bin\ExUmApl.exe register

NOTE: The Web Client settings on your old XPR V6 32-bit will not be copied 
for the Web Client in XPR V7. You must adjust the Web Client after the 
migration. You find a backup of the Web Client installation files in the 
<XPR_Install>\xprWebClient_backup directory.

IMPORTANT: You must set the registry value DisableUserTOSSetting 
under HKLM/SYSTEM/CurrentControlSet/Services/Tcpip/Param-
eters to 0 for the QoS settings of the IP APL to be used for communication.
In most Windows versions this registry value is not configured by default. In 
this case you need to manually add it as REG_DWORD as described in the 
respective passage. Furthermore, the computer system needs to be rebooted 
for the registry modification to take effect. If the IP APL cannot find this 
registry value with the entry 0, a corresponding error message is issued in the 
XPR monitor during the IP APL start.
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2.10  Upgrading from XPR V5 to XPR V7

NOTE: Of XPR V5 you can upgrade only XPR V5 R4 FR13 to XPR V7. Please 
obtain further information from the table in Section 2.1, “Upgrade Versions”, on 
page 13.

NOTE: XPR V5 is supported on 32-bit operating systems only.

Upgrading from XPR V5 to XPR V7 comprises the following major steps:

1. Data backup of the old XPR V5 installation

2. Reinstallation of XPR V7

3. Data restore on the XPR V7 installation

These major steps are detailed in the following sub-sections.

2.10.1  Backing up Data on XPR V5

1. Install the latest hotfixes on the XPR V5. A table in section Upgrade/Update 
of the Release Notes lists the hotfixes according to the versions.

The following hotfixes must be installed:

• Mta-720FR13-15524

• WebApl-720FR13-15524

• WebAssistant-720FR13-15524

• CfgSvc-720FR13-15591

2. Start the Web Assistant and log on as administrator. In the navigator, click on 
Server settings and then on Smart backup and restore. The Smart 
Backup and Restore dialog opens.

IMPORTANT: The Smart Backup and Restore feature assumes the user 
assigned to the MTA service also to be the installing user.

3. Additionally, tick off the TOV7 check box in the options list.

4. Check which of the following check boxes you must activate:
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• NCO backs up the configuration settings onf the Number Conversion 
Object. The NCO configuration files NcoMainTree.xml and 
VariableProposals.xml are backed up. All other files available in the 
<XPR Install>\NCO directory are dynamically created at runtime.

• REGISTRY backs up the entries of the XPR server in the registry. The 
HKLM\Software\PP-COM\MRS section in the registry of the kernel 
computer is backed up in the regexp_serverconf.reg file.

• INFOSTOR backs up the data of the XPR server database. User and 
system data (Correlation database) and the database with the message 
headers (Journal database) are completely exported to the 
fullexp.exp file.

• FOLDERS backs up the data of the message store. A complete copy of 
the directories is created under the share MrsFolders$. This includes 
all messages on the system.

• USERDATA backs up the user-created configurations. A complete copy 
of the directories is created under the share MrsUserData$. This 
includes for example private greetings of the users.

• ISC backs up the configuration settings for a possibly configured system 
networking. A complete copy of the directories is created beneath <XPR 
Install>\ISC for this purpose. The configuration data for the system 
networking is stored there.

• UCC backs up the data of the PostgreSQL database. The PostgreSQL 
database mrsdb is written in the dump.sql file. Furthermore, the 
following files from the <XPR Install>/UCC/application_host/ 
directory are backed up:

– applets/conference/ConferencingApplication.xml
– binders/terminal/bindings/conference.xml
– providers/sip-connectivity/sip-connectivity.xml
– providers/streaming-mps/streaming-mps.xml

The following files are backed up in addition:

<XPR_Install>/cyPHONEWeb/config/*.*
<XPR_Install>/cyPHONEWeb/.keystore
<XPR_Install>/UCC/common/conf/instance_8dff7acb-6780-4b7d-
9089-e2684fc8b326-localhost.xml 
C:\Program Files\webconferenceserver\settings.ini

• SATELLITE backs up the configuration files of a satellite installation. The 
registry section HKLM\Software\PP-COM\MRS of the satellite 
computers is backed up in the <name of the satellite>.reg files.

5. The Backup Path field is allocated with value <XPR_Install>. Change this 
value is required.
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6. Click on Backup now. The backup file is created. It will be used in step 6 on 
page 100 for restore.

NOTE: If the MTA does not operate under a user account, the backup is 
written in the c:\windows\temp directory, otherwise in the temp directory 
of the corresponding user account.  The backup file is a TAR file.

7. If you have installed the Connection APL on a satellite computer, back up the 
configuration data manually.
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2.10.2  Installing the XPR V7 Server

1. Install the XPR V7 server. In doing so please heed the following points:

• Instead of the XPR V5 SMS APL there is the SMSIP APL on XPR V7 . 
Consequently, the SMS APL configuration will get lost during the 
upgrade. The password of user Network Administrator and the Local 
Profile are kept during the upgrade only if the computer name (host name) 
and the IP address of the XPR V5 server computer are also used for the 
XPR 7 server computer.

• Keep the XPR server's name. 

• When performing the installation, deploy for user PGROOT of the 
PostgreSQL database the same password you used when setting up the 
old V5 system. Keep the server name. 

• For systems integrated in Exchange you need to install the ldap, exchapl 
and exumapl; the configuration may occur at a later date. 

• The Web Assistant is used for restore, so you need to configure the 
WebApl now. 

2. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:
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a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.

3. Install the latest hotfixes on the XPR V7 server before starting the restore.

IMPORTANT: The restore assumes all installation and data directories to 
have the same name. The restoration of new installation directories is not 
supported. 

Make sure that the following hotfix has been installed:

• For an XPR V7 server integrated in a Microsoft Exchange 2007/2010 
server: E2k7AplInstaller-810-15204
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4. If the Web Conference server is installed on the same computer as the XPR 
V7 server, perform the configuration for the Web Conference server. Please 
read section Configuring the Web Conference Server in the OpenScape 
Xpressions Server Installation manual on this.
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2.10.3  Restore on the XPRh V7 Server 

Restore

1. Stop the Connection APL service (ConApl).

2. Start the Postgres service.

3. Start the Web Assistant.

4. In the navigator, click on Server settings and then on Smart backup and 
restore. The Smart Backup and Restore dialog opens.

5. Access the Files to restore combo box to select the backup file you created 
in step 6 on page 96 on the XPR V5 computer.

6. Click on Restore.

7. Stop the Postgres service.

8. Open a Microsoft command prompt and execute the renservr command for 
every modified IP address.

renserv OLD_IP NEW_IP

9. Execute the renservr command for every modified computer name.

renserv OLD_MACHINE_NAME NEW_MACHINE_NAME

10. Stop the XPR V7 server. 

Additional Instructions

11. Correct the DNS entries of your XPR server on the DNS server.

12. If the XPR V7 is integrated in a Microsoft Exchange 2007/2010 server, 
deactivate the connector of the XPR V5 in the Exchange server. Execute the 
following command in the Exchange Management Shell to receive the name 
of the Exchange connector: 

Get-ForeignConnector | fl

Enter the following command to disable the Exchange connector:

Set-ForeignConnector -Enabled $false

Activating the XPR V7

1. Stop the XPR V5.

2. Start the XPR V7. 

3. Execute the following sub-steps on the XPR V7 server computer. 

a) Open a Microsoft command prompt.

b) Access the <XPR_Install>\SDKtools directory.

c) Execute the following command:
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infotool export rec=JOURNAL file=journal.txt

This command exports the XPR server journal to the 
<XPR_Install>\SDKtools\journal.txt file.

d) Open this file in an editor.

e) If the last line CONTENTTYPE contains value 4352 or a value greater than 
499 and smaller than 600, replace those values with value 1092 and 
continue with sub-step f.

Otherwise, close the file, delete it and continue with step 4 on page 101.

f) Back up the file.

g) Stop the XPR V7 server. 

h) Enter the following commands in the Microsoft command prompt:

del <XPR_Install>\InfoStor\*.idx

This command deletes all index files. They will be recreated at the fresh 
start of the XPR V7 server.

i) Delete the journal.dat file:

del <XPR_Install>\InfoStor\journal.dat

It will be recreated at the fresh start of the XPR V7 server.

j) Start the XPR V7 server. 

k) Execute the following command in the Microsoft command prompt:

infotool import rec=JOURNAL file=journal.txt

This command imports the journal file in the XPR V7 server. The XPR V7 
server now recognizes old voice messages as voice messages.

4. For systems integrated in Exchange 2007/2010 you need to execute the 
following commands:

• <XPR_Install>\bin\ExchAplConfigurator.exe/exchapl and 
follow the configuration steps.

• <XPR_Install>\bin\ExchAplConfigurator.exe/exumapl and 
follow the configuration steps.

• <XPR_Install>\bin\E2K7Apl.exe install

• <XPR_Install>\bin\E2K7Apl.exe register

• <XPR_Install>\bin\ExUmApl.exe install

• <XPR_Install>\bin\ExUmApl.exe register

5. For systems integrated in Exchange 2003 you need to execute the following 
commands:
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• <XPR_Install>\bin\ExchAplConfigurator.exe/exchapl and 
follow the configuration steps.

• <XPR_Install>\bin\ExchAplConfigurator.exe/exumapl and 
follow the configuration steps.

• <XPR_Install>\bin\E2KApl.exe install

• <XPR_Install>\bin\E2KApl.exe register

• <XPR_Install>\bin\ExUmApl.exe install

• <XPR_Install>\bin\ExUmApl.exe register

NOTE: The Web Client settings on your old XPR V5 will not be copied for the 
Web Client in XPR V7. You must adjust the Web Client after the migration. 
You find a backup of the Web Client installation files in the 
<XPR_Install>\xprWebClient_backup directory.

IMPORTANT: You must set the registry value DisableUserTOSSetting 
under HKLM/SYSTEM/CurrentControlSet/Services/Tcpip/Param-
eters to 0 for the QoS settings of the IP APL to be used for communication.
In most Windows versions this registry value is not configured by default. In 
this case you need to manually add it as REG_DWORD as described in the 
respective passage. Furthermore, the computer system needs to be rebooted 
for the registry modification to take effect. If the IP APL cannot find this 
registry value with the entry 0, a corresponding error message is issued in the 
XPR monitor during the IP APL start.
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2.11  Upgrading from MRS 8.03 to XPR V7

NOTE: You can upgrade an MRS to XPR V7 only from versions MRS 8.0x. 
Please obtain further information from the table in Section 2.1, “Upgrade 
Versions”, on page 13.

NOTE: MRS 8.03 is supported on 32-bit as well as on 64-bit operating systems.

Upgrading from MRS 8.03 to XPR V7 comprises the following major steps:

1. Data backup of the old MRS 8.03 installation

2. Reinstallation of XPR V7

3. Data restore on the XPR V7 installation

These major steps are detailed in the following sub-sections.

2.11.1  Backing up Data on MRS 8.03

1. Install the latest hotfixes on the XPR V5. A table in section Upgrade/Update 
of the Release Notes lists the hotfixes according to the versions.

The following hotfixes must be installed:

• Ucc-803-14924

• WebApl-803-14511

• WebAssistant-803-14511

• ConApl-803-15063

• Mta-803-15218

• CycosOpenSSL-803-20120119
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2. If UCC components are installed, execute the following sub-steps:

a) Change the privileges of the SQL FastViewer service user account to a 
user account that has privileges of the XPR service.

b) Perform the following queries on the Postgres database user interface:

3. Start the Web Assistant and log on as administrator. In the navigator, click on 
Server settings and then on Smart backup and restore. The Smart 
Backup and Restore dialog opens.

IMPORTANT: The Smart Backup and Restore feature assumes the user 
assigned to the MTA service also to be the installing user.

4. Additionally, tick off the TOV7 check box in the options list.

5. Check which of the following check boxes you must activate:

• NCO backs up the configuration settings onf the Number Conversion 
Object. The NCO configuration files NcoMainTree.xml and 
VariableProposals.xml are backed up. All other files available in the 
<XPR Install>\NCO directory are dynamically created at runtime.

• REGISTRY backs up the entries of the XPR server in the registry. The 
HKLM\Software\PP-COM\MRS section in the registry of the kernel 
computer is backed up in the regexp_serverconf.reg file.

• INFOSTOR backs up the data of the XPR server database. User and 
system data (Correlation database) and the database with the message 
headers (Journal database) are completely exported to the 
fullexp.exp file.

• FOLDERS backs up the data of the message store. A complete copy of 
the directories is created under the share MrsFolders$. This includes 
all messages on the system.

• USERDATA backs up the user-created configurations. A complete copy 
of the directories is created under the share MrsUserData$. This 
includes for example private greetings of the users.

• ISC backs up the configuration settings for a possibly configured system 
networking. A complete copy of the directories is created beneath <XPR 
Install>\ISC for this purpose. The configuration data for the system 
networking is stored there.

UPDATE symVCC.symConferenceUserTempl SET InvitationAddress = lower(InvitationAddress);
UPDATE symConferencing.Invitees SET InvitationAddress = lower(InvitationAddress);
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• UCC backs up the data of the PostgreSQL database. The PostgreSQL 
database mrsdb is written in the dump.sql file. Furthermore, the 
following files from the <XPR Install>/UCC/application_host/ 
directory are backed up:

– applets/conference/ConferencingApplication.xml
– binders/terminal/bindings/conference.xml
– providers/sip-connectivity/sip-connectivity.xml
– providers/streaming-mps/streaming-mps.xml

The following files are backed up in addition:

<XPR_Install>/cyPHONEWeb/config/*.*
<XPR_Install>/cyPHONEWeb/.keystore
<XPR_Install>/UCC/common/conf/instance_8dff7acb-6780-4b7d-
9089-e2684fc8b326-localhost.xml 
C:\Program Files\webconferenceserver\settings.ini

• SATELLITE backs up the configuration files of a satellite installation. The 
registry section HKLM\Software\PP-COM\MRS of the satellite 
computers is backed up in the <name of the satellite>.reg files.

6. The Backup Path field is allocated with value <XPR_Install>. Change this 
value is required.

7. Click on Backup now. The backup file is created. It will be used in step 5 on 
page 109 for restore.

NOTE: If the MTA does not operate under a user account, the backup is 
written in the c:\windows\temp directory, otherwise in the temp directory 
of the corresponding user account.  The backup file is a TAR file.

8. If you have installed the Connection APL on a satellite computer, back up the 
configuration data manually.
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2.11.2  Installing the XPR V7 Server

1. Install the XPR V7 server. In doing so please heed the following points:

• Keep the MRS server's name. 

• When performing the installation, deploy for user PGROOT of the 
PostgreSQL database the same password you used when setting up the 
old MRS system. 

• For systems integrated in Exchange you need to install the ldap, exchapl 
and exumapl; the configuration may occur at a later date. 

• The Web Assistant is used for restore, so you need to configure the 
WebApl now. 

• Change the privileges of the SQL FastViewer service user account to a 
user account that has privileges of the XPR service.

2. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:
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a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.

3. Install the latest hotfixes on the XPR V7 server before starting the restore. A 
table in section Upgrade/Update of the Release Notes lists the hotfixes 
according to the versions.

IMPORTANT: The restore assumes all installation and data directories to 
have the same name. The restoration of new installation directories is not 
supported. 

Check that the following hotfixes have been installed:

• Mta-803-15218
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• Ucc-810-xxxx

• For an XPR V7 server integrated in a Microsoft Exchange 2007/2010 
server: E2k7AplInstaller-810-15204

4. If the Web Conference server is installed on the same computer as the XPR 
V7 server, perform the configuration for the Web Conference server. Please 
read section Configuring the Web Conference Server in the OpenScape 
Xpressions Server Installation manual on this.

5. If you have installed UCC components, please read the OpenScape 
Xpressions V7 Server Administration, Administrator Documentation manual 
and follow the instructions in section Backing up the PostgresSQL Database.
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2.11.3  Restore on the XPR V7 Server 

1. If you have installed UC components, stop the Connection APL service 
(ConApl).

2. If you have installed UC components, start the Postgres service.

3. Start the Web Assistant.

4. In the navigator, click on Server settings and then on Smart backup and 
restore. The Smart Backup and Restore dialog opens.

5. Access the Files to restore combo box to select the backup file you created 
in step 7 on page 105 on the MRS 8.03 computer.

6. Click on Restore.

7. If you have installed UC components, stop the Postgres service.

8. Open a Microsoft command prompt and execute the renservr command for 
every modified IP address.

renserv OLD_IP NEW_IP

9. Execute the renservr command for every modified computer name.

renserv OLD_MACHINE_NAME NEW_MACHINE_NAME

10. Stop the XPR V7 server. 

Additional Instructions

11. Correct the DNS entries of your XPP server on the DNS server.

12. If the XPR V7 is integrated in a Microsoft Exchange 2007/2010 server, 
deactivate the connector of the MRS 8.03 in the Exchange server. Execute 
the following command in the Exchange Management Shell to receive the 
name of the Exchange connector: 

Get-ForeignConnector | fl

Enter the following command to disable the Exchange connector:

Set-ForeignConnector -Enabled $false

Activating the XPR V7

1. Stop the MRS 8.03.

2. Start the XPR V7. 

3. Execute the following sub-steps on the XPR V7 server computer. 

a) Open a Microsoft command prompt.

b) Access the <XPR_Install>\SDKtools directory.

c) Execute the following command:
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infotool export rec=JOURNAL file=journal.txt

This command exports the XPR server journal to the 
<XPR_Install>\SDKtools\journal.txt file.

d) Open this file in an editor.

e) If the last line CONTENTTYPE contains value 4352 or a value greater than 
499 and smaller than 600, replace those values with value 1092 and 
continue with sub-step f.

Otherwise, close the file, delete it and continue with step 4 on page 110.

f) Back up the file.

g) Stop the XPR V7 server. 

h) Enter the following commands in the Microsoft command prompt:

del <XPR_Install>\InfoStor\*.idx

This command deletes all index files. They will be recreated at the fresh 
start of the XPR V7 server.

i) Delete the journal.dat file:

del <XPR_Install>\InfoStor\journal.dat

It will be recreated at the fresh start of the XPR V7 server.

j) Start the XPR V7 server. 

k) Execute the following command in the Microsoft command prompt:

infotool import rec=JOURNAL file=journal.txt

This command imports the journal file in the XPR V7 server. The XPR V7 
server now recognizes old voice messages as voice messages.

4. For systems integrated in Exchange 2007/2010 you need to execute the 
following commands:

• <XPR_Install>\bin\ExchAplConfigurator.exe and follow the 
configuration steps.

• <XPR_Install>\bin\E2K7Apl.exe install

• <XPR_Install>\bin\E2K7Apl.exe register

• <XPR_Install>\bin\ExUmApl.exe install

• <XPR_Install>\bin\ExUmApl.exe register

5. For systems integrated in Exchange 2003 you need to execute the following 
commands:

• <XPR_Install>\bin\ExchAplConfigurator.exe and follow the 
configuration steps.

• <XPR_Install>\bin\E2KApl.exe install



Upgrade.fm

Upgrading an XPR without Cluster

Upgrading from MRS 8.03 to XPR V7

A31003-S2370-J102-15-7631, 11/2014
OpenScape Xpressions V7 Upgrade Instructions, Installation Documentation 111

       

• <XPR_Install>\bin\E2KApl.exe register

• <XPR_Install>\bin\ExUmApl.exe install

• <XPR_Install>\bin\ExUmApl.exe register

NOTE: The cyPHONE Web settings on your old MRS 8.03 cannot be copied 
for the Web Client in XPR V7. You must manually adjust the Web Client after 
the migration. You find a backup of the cyPHONE Web installation files in the 
directory <XPR_Install>\cyPHONEWeb.

IMPORTANT: You must set the registry value DisableUserTOSSetting 
under HKLM/SYSTEM/CurrentControlSet/Services/Tcpip/Param-
eters to 0 for the QoS settings of the IP APL to be used for communication.
In most Windows versions this registry value is not configured by default. In 
this case you need to manually add it as REG_DWORD as described in the 
respective passage. Furthermore, the computer system needs to be rebooted 
for the registry modification to take effect. If the IP APL cannot find this 
registry value with the entry 0, a corresponding error message is issued in the 
XPR monitor during the IP APL start.
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2.12  Upgrading Satellite Computers

After upgrading the kernel computer, all satellite computers must be upgraded to 
the same version. 

1. For this purpose, the SatPrep.exe program must first be executed on the 
satellite computer. Please refer to Section 2.12.2, “Preparing the Satellite 
Computers”, on page 113. 

2. You then need to execute the instructions given in Section 2.8.1, “Standard 
Upgrade”, on page 63) to upgrade the already installed components (APLs) 
on each satellite computer. Be sure to select the Repair radio button in step 
5 on page 64 and also in step 33 on page 75.

IMPORTANT: Make sure that all language packets are already installed on the 
kernel computer before they are installed on a satellite computer. A language 
packet may only be uninstalled on a satellite if the satellite computer does not 
have a connection to the kernel computer. 

IMPORTANT: The restoration requires that all installation and data directories 
have the same name. The restoration of new installation directories is not 
supported. 

2.12.1  User Accounts of the XPR Services

Make definitely sure that the following OpenScape Xpressions kernel services 
on the kernel computer and all XPR services installed on the satellites are logged 
on with the same Windows account and password:

• XPR Administrator (mrs)

• XPR Config-Service (cfgsvc)

• XPR Information Store (infostor)

• XPR Message Router (mta)

• XPR Name Locator (nameloc)

• XPR Status Dispatcher (xmrsvc)

This account must provide the following group memberships and privileges: 

• is member of the domain in which the kernel and satellite computer are found

• has local administrator privileges on kernel and satellite computers
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• has the "logon as service" privilege on all satellite computers 

If this is not the case, the kernel computer cannot start the services on the satellite 
computers or the satellite APLs are not displayed in the kernel computer monitor. 

Make sure that all services of the kernel computer run under this user account 
before the upgrade of the satellite computers. After the satellite computer 
upgrade this user account must also be assigned to their XPR services. To furnish 
services with another account, proceed as described in Section 2.12.3, 
“Modifying the Service Account for OpenScape Xpressions Services” further 
below.

2.12.2  Preparing the Satellite Computers

Since new services and a modified configuration were added, the SatPrep.exe 
program must be executed again for each satellite system to install such 
novelties. Proceed as follows:

1. Check that the XPR server on the kernel computer is started and running.

NOTE: This note applies for an upgrade from XPR V5 to XPR V7 only. To 
restore the satellite configuration, you need to use the same computer names 
for the new satellite computers. Please read Section 2.12.4, “Host Name of 
the Satellite Computer” on this.

2. Make sure that the user account under which the services run has the "Logon 
as a service" right on all satellite computers. Please proceed as follows to 
assign the "Logon as a service" right to a user account:

a) Open the Windows security settings on a satellite computer via Start -> 
Control Panel -> Local Security Policy.

b) Doubleclick the Local Policies entry in the list on the left hand side and 
then click User Rights Assignment. The Log on as a service 
Properties dialog opens. This dialog lists all user accounts that have the 
“Log on as a service“ privilege.

c) Click on Add User or Group.... 

d) Enter the name of the user account and click on Check Names. When 
the account has been found in the domain, its name is represented 
underscored. 

e) Click OK. 

f) Click OK. 

g) Close the Windows security settings.
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h) Execute the steps a to g on each satellite computer.

3. Start the SatPrep.exe from the 
Satellite directory on the setup medium. Up comes this dialog:

4. Enter the computer name or the IP address of the kernel computer in the 
Server: field.

5. Verify that the path to the setup directory of the existing XPR server is entered 
in the Destination folder: field. Check which installation path is valid for your 
system. 

6. In the Login information section fill the account information of the domain 
user, under whom the services are started, in the corresponding fields. 
Please note the box on the previous page on this. 

7. Click on Prepare Satellite System. 

The satellite is being prepared.

8. After a successful preparation a dialog is shown that you confirm with OK. If 
errors should occur, you receive an error report with continuative information. 

9. Perform the steps 1 to 7 for each available satellite system. 

10. Perform the upgrade on each satellite system as described in Section 2.8.1, 
“Standard Upgrade”, on page 63. In doing so, check which components are 
already installed on the respective satellite and select exclusively such 
components in the server setup for upgrading.

11. After all satellites have been upgraded, restart the XPR server on the kernel 
computer. This also restarts all services on the satellite computers 
automatically. As soon as all services are restarted on the kernel computer 
and on the satellites, the satellite system upgrade is complete.
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2.12.3  Modifying the Service Account for OpenScape 
Xpressions Services

How to change the account under which a Windows service runs:

1. Click the Start button in the task bar. 

2. Click the Start > Settings > Control Panel menu option.

3. Doubleclick the Administrative Tools icon. 

4. Doubleclick the Services icon. The Services dialog opens.

5. In the services list browse to the OpenScape Xpressions services (they begin 
with XPR).

6. Doubleclick the service to be modified. The properties dialog of this service 
opens.

7. Open the Log On tab.

8. Select This account under Log on as:.

9. Click the Browse... button to select an account with which the service is to 
log on.

10. Enter the corresponding password in the Password: field and confirm it in the 
Confirm password: field.

11. Repeat steps 4 to 8 for each XPR service on the kernel computer and on all 
satellite computers.

NOTE: If the password is changed, either because it expires automatically or the 
customer changes the password for this account, it must also be changed in the 
properties of each single service on the kernel computer and on all satellite 
computers. Please do not forget to inform the customer about this! 

2.12.4  Host Name of the Satellite Computer

If you have changed the host names of the satellite computers while grading up, 
the satellite information will not be restored. There are two options as a remedy.

1. Reconfigure all satellite APLs on each satellite computer.

2. Extract the <hostname>.reg from the backup file. Replace all registry 
paths named: <HKLM\Software\PP-COM> with 
<HKLM\Software\Wow6432Node\PP-COM>. Execute the REG file on each 
satellite computer.
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2.13  Modified and new Features

You find an overview of modified and new features in the Release Notice. Here, 
only some resulting specialties are dealt with.

The features mentioned in the following subsections may be already present 
depending on the XPR version installed.

2.13.1  Name Dialing Default Setting

When recognizing the user entry, the first name is expected before the second 
name by default. This can be configured via the Addressing parameter tab in the 
Script configuration tab in the protocol. Please read on this the section 
Parameter Tab Addressing in the OpenScape Xpressions Server 
Administration manual.

2.13.2  No Support of Media Extension Bridge (MEB)

MEB is not supported. If you upgrade from an XPR version that supports the 
MEB, this upgrade will not automatically uninstall the MEB.

Please note the following:

• During an upgrade, the following applies for the entries on the Device tab of 
the configuration dialog of a telematics APL:

• An entry Unify HiPath CorNet-IP via MEB is maintained. When you 
doubleclick this entry the GUI opens, but setting modifications performed 
in the dialog take no effect in the backend. Only a new installation of the 
XPR server will remove this entry.
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• An entry H.323 Protocol Stack is kept in the list, i. e. H.323 Protocol 
Stack CorNet-IP does not appear though the H.323 protocol stack now 
offers CorNet-IP functionalities as well. After a doubleclick, however, a 
dialog opens that is extended by additional setting options for CorNet-IP. 
Only a new installation of the XPR server effects a correct entry.

IMPORTANT: An MWI previously bound to H.323 must be rebound to H.323 
after the upgrade.

IMPORTANT: When using an HG1500 or HG3550 module and T.38 or G.711 
verify that no HG logging is active.

IMPORTANT: When using T.38 Fax and a HiPath 3000 or HiPath 4000, the fax 
error correction method t38UDPRedundancy must be set in the HG module of the 
HiPath as well as in the IP APL of the XPR, so that the fax transmission error rate 
is kept minimal as far as possible.

2.13.3  Modified default Settings

• Privilege No obligation to change password after first login 
(NO_OBLIG_PWD) 

The user is not obliged to change his/her PIN in the TUI after initial login.

When using VMS, a PIN may be enabled for the user by means of a customer 
parameter. This is particularly useful when the user has already identified him/
herself by his/her Hicom-PIN.

Users who do not yet have a PIN and have not been assigned this privilege 
are prompted to assign an individual PIN the first time they log on with the 
default PIN 000000. This default PIN only applies to the default TUI 
configuration profile!

If the user or administrator have already defined a PIN via the Web Assistant, 
this PIN is used without the user being compelled to assign a new one. 

In the Web Assistant the user may keep a default password or PIN assigned 
by the administrator and is not prompted to change it at the initial log-in.

• IBM/Lotus Notes default settings

The registry keys NDLConversion_FormPrintMode and 
NDLKeepNotesClientOpened are active by default. For details please refer to 
the installation and administration manual IBM Notes Gateway.
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2.13.4  Conversion from PDF to Fax

In the past, the conversion from PDF to fax was done by the Adobe Reader 
application. In the new version, a considerable gain of velocity has been obtained 
by implementing GhostScript. 

The upgrade of a system in which the conversion was done by the Adobe Reader, 
to the current version with GhostScript support does not require any further 
adjustments. If you install a program at a later date that is registered in the 
operating system for the extension .pdf, no adjustments will be required either.

2.13.5  BIRT

BIRT (Business Intelligence and Reporting Tool) is a free-of-charge alternative to 
Crystal Reports for creating reports (see Section 2.3.18, “BIRT as Alternative to 
Crystal Reports”, on page 54).

2.13.6  Keeping Menuconfi.ini

When performing a telematic hotfix or an upgrade, the Menuconfig.ini file will not 
be overridden. Customer-specific modifications may be performed in this file. 
When performing a telematic hotfix or an upgrade, the default_menuconfig.ini file 
will be overridden and used. The default_menuconfig.ini file must not be 
customized. If no menuconfig.ini can be found, the default_menuconfig.ini file is 
used as fall-back solution. 

2.13.7  Fax Transmission

How to transmit fax messages:

• Via the ISDN APL (classic fax)

• By T.38 via the IP APL (fax as data). This may occur via H.323, SIP or CorNet-
IP, but not via TAPI.

An IP APL can be operated in parallel to an ISDN APL on one computer. One IP 
APL cannot support two protocols of the infrastructure layer (e. g. H.323, CorNet-
IP or SIP) in parallel. But the following scenarios are possible, for example, 
provided the protocols mentioned are supported by the connected PBX:

• Parallel operation of Voice via H.323 and T.38 Fax via H.323

• Parallel operation of Voice via SIP and T.38 Fax via SIP.
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You find details on this in the OpenScape Xpressions Server Administration 
manual. The IP APL cannot be instantiated on a computer system several times. 
However, it is well possible to install several IP APLs in a distributed XPR system.

2.13.8  SMS Connector

With XPR V7 R1 the SMS APL and the SMSIPAPL were combined in one APL. 
In the upgrade, already configured lines are automatically converted, so that no 
special steps are required. The GSM adapter monitoring has changed its 
behavior. Up to now, the associated SMS APL was completely shut down. For 
each GSM adapter a line is now available, which is only stopped. The 
corresponding SNMP message has therefore changed.

Old: There are technical problems regarding your SmsBox. Shutdown SmsApl. 

New: There are technical problems regarding your SmsBox. Please verify as 
soon as possible. 

2.13.9  Smart Client Updates

The following client-setup packages can now be selected during the server 
installation and stored in a share on the server. Via the MSP, an update for the 
installed clients is then searched for and, if found, made available. In case of 
components such as the local Outlook forms for SMTP that do not required an 
MSP the correct update server may be asked for.

• Communications

• Application Builder

• Lotus Notes conference plugin

• Lotus Notes fax printer driver

• Lotus Notes ActiveX components

• Local Outlook forms for SMTP

• Outlook conference plugin

• Server-based forms client components

• Server forms
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Upgrading an XPR in a Cluster

3  Upgrading an XPR in a Cluster

A cluster is a group of independent computer systems that are called a node and 
cooperate as one system. The purpose of a cluster is to provide the clients with 
applications and resources with increased availability or improved performance, 
and to minimize downtimes. There are two types of clusters:

• In case of a performance cluster, several nodes are combined to increase the 
performance compared to a single server.

• In an availability cluster, each node is able to perform the tasks of another 
node from the cluster if required. If a node is not available owing to 
maintenance work or technical failures, another node immediately takes over 
the tasks of the unavailable one. The XPR server in a cluster is always 
operated in an availability cluster, i.e. always only one node may operate as 
XPR server.

When upgrading an XPR in the cluster, the same specifications apply as for an 
XPR without cluster. Only the proceedings are different, and also please note the 
restrictions listed in the following.

Node 1 Node 2

Interconnection

Client computers

Volume for cluster 
configuration and 

resources 
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3.1  Restrictions

1. Refer to the service documentation OpenScape Xpressions Release Notice 
for details about the supported operating systems for clusters.

2. On the two cluster nodes the following programs may be locally installed on 
the nodes but not on the cluster. Please note that if licenses are required, one 
license must be purchased for each node.

a) Client License Management (CLM)

b) Business Intelligence and Reporting Tool (BIRT)

c) Text-To-Speech (TTS)

d) Automatic Speech Recognition (ASR)

e) ACD Supervisor

f) Application Builder

3. The tables in section “Configuring XPR Services as Resources“ in the 
OpenScape Xpressions Cluster Installation setup manual tell you which XPR 
services can be installed on a cluster.

Please note the differentiation between mandatory and optional services as 
well as between services with general (GA) and limited availability (LA).

4. The Connection APL (UCC, Web Conference Server, PostgreSQL and 
optiClient 130 Web) must neither be installed in the cluster nor locally on a 
cluster node.

5. C++ 2008 Redistributable must be installed on all available nodes to grant the 
system starting up smoothly.

6. If you do not perform the application conversion with Ghostscript but with 
Microsoft Office, you need to install Microsoft Office on both nodes. Please 
remember that you need two licenses for this purpose.

7. For both installations and upgrades alike applies that audio conferences are 
not supported for an XPR connected to HiPath 3000 V5, V6 and V7, HiPath 
4000 V3 and V4, because the program SIPControl is no longer supported by 
Dialogic Diva. 
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3.2  Upgrading from XPR V6 64-bit to XPR V7

3.2.1  Upgrading XPR on Windows Server 2003 in the 
Cluster

Upgrading an XPR in the cluster requires special proceedings.

IMPORTANT: Update the license service (step 5) before you upgrade the 
server (step 6). Complications may occur otherwise. 

1. Perform a system backup to be able to restore the previous status in case of 
a failed upgrade.

2. Start the cluster administrator via Start > Programs > Administrative Tools 
> Cluster Administrator. Open a connection to the cluster with File > Open 
Connection or click the corresponding icon in the cluster administrator's 
toolbar. In the Action field select the action Open connection to cluster. In 
the Cluster or server name field select the computer name of the virtual 
server on which the XPR is installed. If no computer name is displayed, click 
on Browse to select one. Click the OK button to open the connection to the 
cluster.

3. Move the group in which the XPR resources are compiled to the node on 
which the XPR was installed first. This is the node the registry of which 
contains the 

folder.

You move the group by clicking with the right mouse button in the left-hand 
window of the cluster administrator on the group for the installed XPR server 
and selecting the Move Group option in the context menu.

4. Bring all resources of this XPR group offline. Then bring the license service 
online. This is important as the replication of the registry in the cluster 
depends on the license service online status.

5. Execute all instructions given in chapter “Creating a Command Prompt as 
Resource” of the OpenScape Xpressions Cluster Installation setup manual, if 
no command prompt has yet been created as resource.

IMPORTANT: This command prompt is different from a normal command 
prompt as the commands executed in it are executed in the cluster context. 
This means that, for example, the hostname command in this command 
prompt represents the name of the cluster, thus the name you find in the 
cluster administrator in the XPR group with the resource of type Network 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cycos AG\Server Installation
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Name on the Parameters tab in the Name field (see installation manual 
OpenScape Xpressions Cluster Installation ). If this command is executed in 
a normal command prompt, the computer name will be put out.

IMPORTANT: All resources this command prompt depends on are automat-
ically brought online also. 

IMPORTANT: Start the Windows Explorer exactly in this way as only then the 
Windows Explorer will be executed in the cluster context. 

6. Bring this command prompt online. In this command prompt enter explorer 
and push the <ENTER> key. The Windows Explorer opens.

7. In step 6 on page 124 you have started a Windows Explorer. In this Windows 
Explorer start the file 
XpressionsInstall\Cluster\clusterprep.exe on the XPR setup 
medium. Enter the cluster name and click on the OK button.

NOTE: As an alternative you can execute the file 
XpressionsInstall\Cluster\clusterprep.exe in the command 
prompt in the cluster context that you have started in step 5 on page 123.

IMPORTANT: Start clusterprep.exe exactly in this way as only then it 
will be executed in the cluster context.

8. Upgrade the license service

a) Bring the XPR group offline.

b) In step 6 on page 124 you have started a Windows Explorer. In this 
Windows Explorer start the file 
XpressionsInstall\Prerequisites\LicSvcSetup.exe on the 
XPR setup medium. Perform the installation.

NOTE: As an alternative you can execute the file 
XpressionsInstall\Prerequisites\LicSvcSetup.exe in the 
command prompt in the cluster context that you have started in step 5 on 
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page 123.

IMPORTANT: Start LicSvcSetup.exe exactly in this way as only then 
it will be executed in the cluster context.

c) Bring the license service online. Move the XPR group to the second node 
and test whether the license service can be correctly brought online there 
also. Move the license service back to the first node.

d) Use this Windows Explorer to start the 
XpressionsInstall\Server\Setup.exe file on the XPR setup 
medium for the upgrade.

IMPORTANT: Do not start the XpressionsInstall\Setup.exe file. 
It may only be used if no cluster installation is available.

e) If you wish to install another language, start the Setup.exe in the 
appropriate language directory in this Windows Explorer, for example
XpressionsInstall\Languages\French\Setup.exe

to install the French language.

IMPORTANT: In the dialogs offered to you, perform exactly the same 
settings as in step 8d on page 125. 

For example, if you have selected the Repair option in the server setup, 
you also need to select Repair when installing further languages. If, 
instead, you have selected the Modify option in the server setup, you also 
need to select Modify when installing another language. 

9. After the setup has terminated, set the XPR services to Manual and specify 
their login account as described in the chapters “Stopping XPR Services” and 
“Creating a Login Account for XPR Services” in the OpenScape Xpressions 
Cluster Installation setup manual.

10. If required, check and modify keys, which specify node names, in the registry 
under HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM 
according to the instructions given in chapter “Reassignment of the Computer 
Name in the Registry“ of the OpenScape Xpressions Cluster Installation 
setup manual.

11. Set the registry key

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM\MRS\TcpApl\NwPlugTcp\BindAddress
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to the value of the IP address described in chapter “Specifying a new IP 
Address as Resource” of the OpenScape Xpressions Cluster Installation 
setup manual.

If this key does not exist, create it.

12. For upgrades from a version lower then V7 R1 we recommend to execute the 
CompactDB tool to reduce the database size by following the instructions in 
the “CompactDB” section of the administrator documentation OpenScape 
Xpressions Server Administration.

NOTE: You can reduce the database size later at any time when XPR is not 
in operation and all resources in the XPR group are offline. 

13. Bring all resources of the XPR group online. We recommend to test whether 
the XPR can be moved to the second node and back again.

14. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:
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a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.

15. Execute the following substeps on all nodes to start the license service 
automatically after a fail over:

a) Connect the setup medium used to the node.

b) Search the XpressionsInstall\Prerequisites\ directory on the 
setup medium for the following files and start them locally on the node:

• vcruntimeinst.exe

• vcredist_x86.exe

• vcredist_x64.exe
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• vc9\vcredist_x86.exe

• vc10\vcredist_x86.exe

NOTE: No dialog window announcing the end of this file's execution will be 
displayed.

16. Start the file r:\OpenScape\xpr\SDKTools\SystemVersionInfo.exe 
or r:\OpenScape\xpr\SDKTools\FileVersionInfo.exe to check the 
version numbers of the installed APLs. In this process, r:\OpenScape\xpr 
is the xpr directory on the cluster drive (see the OpenScape Xpressions 
Cluster Installation) setup manual. This file can be started in any command 
prompt or Windows Explorer. It need not be the command prompt 
respectively Windows Explorer described in step dd on page 125.
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3.2.1.1  Upgrading the Infostor Resource

If the infostor resource is of type Generic Service and not of type mrsClusRes, 
the following steps must be performed:

1. Copy the mrsclusres.dll file from the
XpressionsInstall\AddOn\Misc\Cluster directory on the XPR setup 
medium to the %WindowsInstallDir%\cluster directory on both nodes. 
If Windows does not permit this because of the File in use message, stop the 
cluster service before copying and reboot it after copying.

2. Start on each node a command prompt without cluster context. In the 
command prompt execute the

cluster resourcetype mrsclusres /create /dll:mrsClusRes.dll

command. This registers the resource type mrsClusRes with the cluster. 
Resources of this type can now be created.

3. We recommend to set the second node to Pause Node to prevent a possible 
failover.

4. Open the cluster administrator via Start > Programs > Administrative Tools 
> Cluster Administrator.

5. In the cluster administrator, click with the left mouse button on the folder of 
the group for the XPR server. 

6. Remove all dependencies of other resources, for example of the XPR 
Message Router, on the Infostor resource.

IMPORTANT: If you do not perform this step and remove the Infostor 
resource in the next step, all resources that depend on the Infostor resource 
will also be removed.

How to remove the dependencies:

a) Click with the right mousebutton a resource that depends on the Infostor 
resource.

b) Select Properties.

c) Click the Dependencies tab.

d) Push the Modify button.

e) In the Dependencies field select the entry for the Infostor resource of 
type Generic service.

f) Push the <-- button.

g) Push the OK button.
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h) Push the OK button.

i) Execute these substeps for all other resources that depend on the 
Infostor resource.

7. Remove the Infostor resource by clicking it with the right mousebutton and 
selecting Delete.

8. In the cluster administrator, click with the right mouse button on the folder of 
the group for the XPR server. 

9. Select in the context menu the option New > Resource or from the File menu 
the option New > Resource.

The New Resource dialog opens.

10. In the Name field specify a unique name for the service, for example XPR 
Information Store Res. 

11. Optional: Enter in the Description field a supplementary description for the 
new service.

12. In the Resource type drop-down menu select the mrsClusRes option.

IMPORTANT: Very important! Create only one resource of type 
mrsClusRes. If another resource of this type is created, the cluster adminis-
trator cannot be operated anymore.

13. In the Group drop-down menu select the group in which the XPR services are 
executed.

14. Ignore the Run this resource in a separate Resource Monitor option.

15. Click on Next.

The Possible Owners dialog appears.

16. From the Available nodes list select the nodes to which the cluster 
configuration and the resources are transferred in case of a failover.

a) In the Available nodes list select the desired node.

b) Click on the Add-> button to shift the selected nodes into the Possible 
owners list.

c) If you want to remove a node from the list Possible owners, select this 
node in the list and click on the <-Remove button.

17. Click on the Next > button after you have selected all required nodes.

The Dependencies dialog opens.
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a) In the Available resources list select 

• the resource of type Network Name,

• the resource of the status dispatcher and 

• the drive on which the Infostor files are found (cluster drive).

b) Click the Add-> button. The selected entries will be moved to the 
Resource dependencies list.

A concluding confirmation dialog is displayed.

18. In this confirmation dialog click on the OK button to return to the cluster 
administrator overview.

19. In step 6 on page 129 you have removed the dependency of other resources 
on the Infostor resource. These resources must now be made dependend on 
the Infostor resource again.

20. The configuration of the new resource is thus complete. The right window of 
the cluster administrator now displays a new resource of type mrsClusRes.

NOTE: When creating a resource of type mrsClusRes, no parameters and no 
values are entered for the registry replication.
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3.2.1.2  Configuring the stunnel Resource

If no stunnel resource has been configured yet, you need to do this via the 
following steps.

1. Set on both nodes in the registry folder

the value of the BindAddress key to the IP address of the virtual XPR 
server (see resource of type IP Address in the group for the XPR server, 
Parameters tab, Address field).

IMPORTANT: Neither enter the IP address of the resource of type IP 
Address of the cluster group nor the IP address of the node.

2. On the node on which the XPR installation was performed first (node 1) open 
the service administration by selecting Start > Programs > Administrative 
Tools > Services.

3. Stop the stunnel service (if it runs) by clicking the service with the right 
mousebutton and selecting the Stop Service option from the context menu.

4. Click with the right mouse button on the stunnel service and select 
Properties from the context menu.

5. In the Startup type field select the Manual option.

6. Click on the OK button to close the dialog.

7. Configure a resource for the stunnel service according to the description in 
the OpenScape Xpressions Cluster Installation manual. Verify that this 
resource depends on the TCP APL service.

8. Open the cluster administrator on the second node.

9. Stop the stunnel resource if it runs.

10. Move the group with the resources for the XPR to the second node.

11. Open the command prompt in the cluster context, i. e. the command prompt 
created as resource. 

12. In this command prompt enter the stunnel -install command using the 
XPR setup path <XPR_Install>/bin/stunnel.

IMPORTANT: Enter this command only in the command prompt that exists 
in the cluster context. This means that, for example, the hostname 
command in this command prompt represents the name of the cluster, thus 
the name you find in the cluster administrator in the XPR group with the 
resource of type Network Name on the Parameters tab in the Name field 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-Com\MRS\Tcpapl\NWPlugTCP
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(see installation manual OpenScape Xpressions Cluster Installation ). If, in 
contrast, the hostname command is executed in a normal command prompt, 
the computer name will be put out.

13. Bring the stunnel resource online.

a) In the cluster administrator, click with the right mouse button on the folder 
of the group for the XPR server.

b) Select in the right portion the stunnel resource with the right mousebutton.

c) Select Bring Online.
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3.2.2  Upgrading XPR on Windows Server 2008/2012 
in the Cluster

Upgrading an XPR in the cluster requires special proceedings.

IMPORTANT: Update the license service (step 5) before you upgrade the 
server (step 6). Complications may occur otherwise. 

1. Perform a system backup to be able to restore the previous status in case of 
a failed upgrade.

2. Start the Failover Cluster Management via start > Programs > 
Administrative Tools > Failover Cluster Management. 

3. Move the application in which the XPR resources are compiled to the node 
on which the XPR was installed first. This is the node the registry of which 
contains the 

folder.

You move the application by rightclicking the application for the installed XPR 
server in the left window of the Failover Cluster Management and selecting 
the option Move this service or application to another node > 1 - Move to 
node <name of the first node> in the context menu.

4. On this node, start the 
XpressionsInstall\Cluster\clusterprep.exe file on the XPR 
setup medium in a command prompt or in the Windows Explorer. Enter the 
cluster name and click on the OK button.

5. Bring all resources of this XPR application offline. Then bring the license 
service online. This is important as the replication of the registry in the cluster 
depends on the license service online status.

6. Upgrade the license service.

a) Bring the XPR application offline.

b) Start the 
XpressionsInstall\Prerequisites\LicSvcSetup.exe file on 
the XPR setup medium in a command prompt or in the Windows Explorer.

c) Perform the installation.

d) Bring the license service online. Move the XPR application to the second 
node and test whether the license service can be correctly brought online 
there also. Move the license service back to the first node.

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Cycos AG\Server Installation
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If the attempt to bring the resource online fails, you can execute one or 
both of the substeps 14a on page 136 and 14b on page 136 to solve the 
problem. This depends on whether the resource's state is Offline or 
Failed after the attempt or an error message appears.

7. Bring all resources online that have been configured for the XPR.

8. Execute the XpressionsInstall\Server\Setup.exe file to start the 
upgrade.

IMPORTANT: Do not start the XpressionsInstall\Setup.exe file. It 
may only be used if no cluster installation is available.

9. If you wish to install another language, start the Setup.exe in the 
appropriate language directory in this Windows Explorer, for example
XpressionsInstall\Languages\French\Setup.exe to install the 
French language.

IMPORTANT: In the dialogs offered to you, perform exactly the same 
settings as in step 8 on page 135. 

For example, if you have selected the Repair option in the server setup, you 
also need to select Repair when installing further languages. If, instead, you 
have selected the Modify option in the server setup, you also need to select 
Modify when installing another language. 

10. After the setup has terminated, set the XPR services to Manual and specify 
their login account as described in the chapters “Stopping XPR Services” and 
“Assigning a Login Account for XPR Services” in the OpenScape Xpressions 
Cluster Installation setup manual.

11. If required, check and modify keys, which specify node names, in the registry 
under HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM 
according to the instructions given in chapter “Reassignment of the Computer 
Name in the Registry“ of the OpenScape Xpressions Cluster Installation 
setup manual.

12. Set the registry key

to the value of the IP address described in chapter “Specifying a new IP 
Address as Resource” of the OpenScape Xpressions Cluster Installation 
setup manual.

If this key does not exist, create it.

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM\MRS\TcpApl\NwPlugTcp\BindAddress
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13. For upgrades from a version lower then V7 R1 we recommend to execute the 
CompactDB tool to reduce the database size by following the instructions in 
the “CompactDB” section of the administrator documentation OpenScape 
Xpressions Server Administration.

NOTE: You can reduce the database size later at any time when XPR is not 
in operation and all resources in the XPR group are offline. 

14. Bring all resources of the XPR application online. We recommend to test 
whether the XPR can be moved to the second node and back again.

If the attempt to bring the resource online fails, you can execute one or both 
of the following substeps to solve the problem. This depends on whether the 
resource's state is Offline or Failed after the attempt or an error message 
appears:

a) Open a command prompt and enter the command as follows:

sc config <service name> depend= / 

IMPORTANT: Please note that a blank must follow the equals sign.

Example:

sc config licsvc depend= /

Example output of a successful performance:

C:\Users\administrator.X>sc config licsvc depend= /

[SC] ChangeServiceConfig SUCCESS

C:\Users\administrator.X>

IMPORTANT: Be sure not to enter a command according to the 
following pattern:
sc config <service name> depend= \
The consequence of this wrong command would be that the resource to 
be created for this service could not be brought online.
Even in case of this wrong command the described message of 
successful execution is issued.

b) Execute the replacement described below:

IMPORTANT: Very important! Be sure to replace the local computer 
name only in the two specified registry database folders 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SIEMENS and 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM in the 
following steps. In all other registry folders the local computer name must 
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definitely be maintained, since otherwise the Windows operating system 
may not work any more. If required, create a backup copy of the registry 
before changing keys in it.

Start the registry editor. Click on Start > Run. Enter the regedit command 
in the Open field. The registry editor starts.

Execute the following substeps to replace the name:

In the Edit menu click on the Find... option. The Find dialog opens.

In the Find what field enter the computer name of the local node. Activate 
the options Keys, Values and Data. Click on Find next. The next 
occurrence of the computer name is displayed. 

If you are in the registry database folder 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Siemens or 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM (see the 
status bar), replace the local computer name with the value of <network 
name> in Name:<network name> in the Server Name category in the 
middle section of the Failover Cluster Management.

More changes may have to be performed in a key. If, for example, XPR is 
the name of the XPR server in the cluster system, TLCLKN1 is the name 
of the node in the cluster, and the key 

has, for example, the two-line value

\\XPR\MrsMonitor

\\TLCLKN1\MrsMonitor

, the second line must be removed without substitution.

IMPORTANT: Do not replace the name of the local computer with the 
application's name.

Push key F3 to find the next appearance. In doing so be sure not to leave 
the above registry folders.

Repeat these steps until all appearances of the computer name are 
replaced.

15. Bring the XPR application online.

16. Log on to the Web Assistant as administrator and open the menu option 
Server settings > XPR Authentication.

The following page will be displayed:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-COM\MRS\MRS Globals\Monitor Directory
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a) Verify the settings. Refer to the section “Defining Passwort Policies” in the 
user guide Web Assistant for details about the parameters. Consider the 
section “Securing the User Interfaces” in the planning guide OpenScape 
Xpressions Security Checklist. 

b) If you have changed values, click on the Save button.

17. Execute the following substeps on all nodes to start the license service 
automatically after a fail over:

a) Connect the setup medium used to the node.

b) Search the XpressionsInstall\Prerequisites\ directory on the 
setup medium for the following files and start them locally on the node:

• vcruntimeinst.exe

• vcredist_x86.exe

• vcredist_x64.exe
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• vc9\vcredist_x86.exe

• vc10\vcredist_x86.exe

NOTE: No dialog window announcing the end of this file's execution will be 
displayed.

18. Start the r:\OpenScape\xpr\SDKTools\SystemVersionInfo.exe or 
r:\OpenScape\xpr\SDKTools\FileVersionInfo.exe file to check 
the version numbers of the installed APLs. r:\OpenScape\xpr is the xpr 
directory on the cluster drive (see the installation guide OpenScape 
Xpressions Cluster Installation).
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3.2.2.1  Upgrading the Infostor Resource

If the infostor resource is of type Generic Service and not of type mrsClusRes, 
the following steps must be performed:

1. Copy the mrsclusres.dll file from the
XpressionsInstall\AddOn\Misc\Cluster directory on the XPR setup 
medium to the %WindowsInstallDir%\cluster directory on both nodes. 
If Windows does not permit this because of the File in use message, stop the 
cluster service before copying and reboot it after copying.

2. Start command prompt on each node. In the command prompt execute the

cluster resourcetype mrsclusres /create /dll:mrsClusRes.dll

command. This registers the resource type mrsClusRes with the cluster. 
Resources of this type can now be created.

3. We recommend to set the second node to Pause to prevent a possible 
failover.

4. Open the Failover Cluster Management under start > Programs > 
Administrative Tools > Failover Cluster Management.

5. In the Failover Cluster Management, click the folder of the application for the 
XPR server. 

6. Remove all dependencies of other resources, for example of the XPR 
Message Router, on the Infostor resource.

IMPORTANT: If you do not perform this step and remove the Infostor 
resource in the next step, all resources that depend on the Infostor resource 
will also be removed.

How to remove the dependencies:

a) Click with the right mousebutton a resource that depends on the Infostor 
resource.

b) Select Properties.

c) Click the Dependencies tab.

d) In the Specify ... field select the entry for the Infostor resource of type 
Generic service.

e) Push the Delete button.

f) Push the OK button.

g) Execute these substeps for all other resources that depend on the 
Infostor resource.
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7. Remove the Infostor resource by clicking it with the right mousebutton and 
selecting Delete.

8. In the Failover Cluster Management, rightclick the folder of the application for 
the XPR server. 

9. Select Add a resource > More resources > 8 - Add mrsclusres in the 
context menu.

IMPORTANT: Very important! Create only a single resource of type 
mrsClusRes. If another resource of this type is created, the Failover Cluster 
Management cannot be operated anymore.

If you see the following error message, click on No, copy the 
mrsclusres.dll file to all nodes and select Add a resource > More 
resources > 8 - Add mrsclusres once more.

10. An entry New mrsclusres is created in the Failover Cluster Management 
under the Other Resources category.
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11. Double-click this entry.

NOTE: In case of a resource of type mrsClusRes, no parameters and no 
values are entered for the registry replication.

12. Change the value of field Resource Name according to your requirements, 
for example in Information Store Res.
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13. Click on the Dependencies tab.

a) Click on the Insert > button.

b) Click on the triangle to the right of the newly created field.

c) Select Cluster Disk 2.

a) Click on the Insert > button.

b) Click on the triangle to the right of the newly created field.

c) Select File Server Res.

a) Click on the Insert > button.

b) Click on the triangle to the right of the newly created field.

a) Select the Status Dispatcher Res.

b) Click on the Insert > button.

c) Click on the triangle to the right of the newly created field.

d) Select the Name: UMKernelServer.

NOTE: It is not sufficient to enter the dependencies of the resource XPR 
Information Store Res on File Server Res and Status Dispatcher Res, 
though XPR Information Store Res depends on Cluster Disk 2 via File 
Server Res and on Name: UMKernalServer via File Server Res and via 
Status Dispatcher Res indirectly. 
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14. Click on the Policies tab.

15. Perform the settings according to the description in section “Failover and 
Failback” in the OpenScape Xpressions Cluster Installation setup manual.

16. Click on the Advanced Policies tab.

a) Verify that the checkboxes for all cluster nodes are active in the topmost 
field.

b) Verify that the Run this resource in a separate Resource Monitor is 
inactive.
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17. Click on the OK button to complete the configuration of the service as 
resource and to return to the Failover Cluster Management. 

18. If some dependencies of this resource on other resources were not entered 
or all are missing, the following error message appears:

a) Click on No.

b) Execute step 13 on page 143. Be sure to make XPR Information Store 
Res dependent on all resources mentioned there.

c) Click the OK button.

19. In the middle section of the Failover Cluster Management select the just 
created resources with the right mouse button and select Bring this 
resource online.

If the attempt to bring the resource online fails, you can execute one or both 
of the substeps 14a on page 136 and 14b on page 136 to solve the problem. 
This depends on whether the resource's state is Offline or Failed after the 
attempt or an error message appears.

NOTE: The Eventlog may deliver further notes for bug fixing. The meaning 
of an error code is delivered by the net helpmsg <error code> 
command. The net helpmsg 1075 command delivers for example the 
following output:
The dependency service does not exist or has been marked 
for deletion.

20. In step 6 on page 140 you have removed the dependency of other resources 
on the Infostor resource. Now make these resources dependend on the 
Infostor resource again.

21. The configuration of the new resource is thus complete. 
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3.2.2.2  Configuring the stunnel Resource

If no stunnel resource has been configured yet, you need to do this via the 
following steps.

1. Set on both nodes in the registry folder

the value of the BindAddress key to the IP address of the virtual XPR server 
(value of <IP address> in IP Address:<IP address> in the category Server 
Name in the middle section of the Failover Cluster Management). If the 
BindAddress key does not exist, create it (type REG_SZ).

IMPORTANT: Do not enter the IP address of the node.

2. On the node on which the XPR installation was performed first (node 1), open 
the service administration by selecting Start > Programs > Administrative 
Tools > Services.

3. Stop the stunnel service (if it runs) by clicking the service with the right 
mousebutton and selecting the Stop Service option from the context menu.

4. Click with the right mouse button on the stunnel service and select 
Properties from the context menu.

5. In the Startup type field select the Manual option.

6. Click on the OK button to close the dialog.

7. Configure a resource for the stunnel service according to the description in 
the OpenScape Xpressions Cluster Installation manual. Verify that this 
resource depends on the TCP APL service.

8. Open the Failover Cluster Management on the second node.

9. Stop the stunnel resource if it runs.

10. Move the application with the resources for the XPR to the second node.

11. Enter the following command in a command prompt on the second node:

sc create stunnel binpath= “<XPR_Install>/bin/stunnel/
stunnel.exe

IMPORTANT: Please note that a blank must follow the equals sign.

12. Bring the stunnel resource online.

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\PP-Com\MRS\Tcpapl\NWPlugTCP
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a) In the Failover Cluster Management, rightclick the folder of the application 
for the XPR server.

b) Select in the right portion the stunnel resource with the right mousebutton.

c) Select Bring this resource online.

If the attempt to bring the resource online fails, you can execute one or both 
of the substeps 14a on page 136 and 14b on page 136 to solve the problem. 
This depends on whether the resource's state is Offline or Failed after the 
attempt or an error message appears.

NOTE: The Eventlog may deliver further notes for bug fixing. The meaning 
of an error code is delivered by the net helpmsg <error code> 
command. The net helpmsg 1075 command delivers for example the 
following output:
The dependency service does not exist or has been marked 
for deletion.
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3.3  Upgrading from XPR V6 32-bit to XPR V7

Execute the following steps:

1. Follow the instructions in Section 2.9.1, “Data Backup on XPR V6 32-bit”, on 
page 87.

NOTE: It is irrelevant which of the two nodes is online during the data backup 
and whether all resources are online.

2. Perform a fresh installation according to the setup guide OpenScape 
Xpressions Clusterinstallation and heed the following points for this process:

a) The following points of the fresh installation may be identical with the old 
installation but do not have to.

• The group name (default: group0) for the XPR server

• The application name for the XPR server

• The operating system

• The letter for the quorum drive (default: r:)

b) Heed the instructions in Section 2.9.2, “Installing the XPR V7 Server”, on 
page 90.

3. Follow the instructions in Section 2.9.3, “Restore on the XPR V7 Server”, on 
page 92. Heed the following points:

a) When you execute the renserv commands mentioned in Section 2.9.3, 
“Restore on the XPR V7 Server”, on page 92, use the IP address of the 
virtual server and none of the following IP addresses:

• IP address of the cluster

• IP address of one of the two nodes for the internal cluster connection 
(Interconnect)

• IP addresses of the two nodes

The same applies for the computer names.

You find details on this in the setup guide OpenScape Xpressions 
ClusterInstallation.

b) It is irrelevant which of the two nodes is online during the data restore.
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3.4  Upgrading from XPR V5 32-bit to XPR V7

Execute the following steps:

1. Follow the instructions in Section 2.10.1, “Backing up Data on XPR V5”, on 
page 94.

NOTE: It is irrelevant which of the two nodes is online during the data backup 
and whether all resources are online.

2. Perform a fresh installation according to the setup guide OpenScape 
Xpressions Clusterinstallation and heed the following points for this process:

a) The following points of the fresh installation may be identical with the old 
installation but do not have to.

• The group name (default: group0) for the XPR server

• The application name for the XPR server

• The operating system

• The letter for the quorum drive (default: r:)

b) Heed the instructions in Section 2.10.2, “Installing the XPR V7 Server”, 
on page 97.

3. Follow the instructions in Section 2.10.3, “Restore on the XPRh V7 Server”, 
on page 100. Heed the following points:

a) When you execute the renserv commands mentioned in Section 2.10.3, 
“Restore on the XPRh V7 Server”, on page 100, use the IP address of the 
virtual server and none of the following IP addresses:

• IP address of the cluster

• IP address of one of the two nodes for the internal cluster connection 
(Interconnect)

• IP addresses of the two nodes

The same applies for the computer names.

You find details on this in the setup guide OpenScape Xpressions 
ClusterInstallation.

b) It is irrelevant which of the two nodes is online during the data restore.
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3.5  Upgrading from MRS 8.03 to XPR V7

Execute the following steps:

1. Follow the instructions in Section 2.11.1, “Backing up Data on MRS 8.03”, on 
page 103.

NOTE: It is irrelevant which of the two nodes is online during the data backup 
and whether all resources are online.

2. Perform a fresh installation according to the setup guide OpenScape 
Xpressions Clusterinstallation and heed the following points for this process:

a) The following points of the fresh installation may be identical with the old 
installation but do not have to.

• The group name (default: group0) for the XPR server

• The application name for the XPR server

• The operating system

• The letter for the quorum drive (default: r:)

b) Heed the instructions in Section 2.11.2, “Installing the XPR V7 Server”, on 
page 106.

3. Follow the instructions in Section 2.11.3, “Restore on the XPR V7 Server”, on 
page 109. Heed the following points:

a) When you execute the renserv commands mentioned in Section 2.11.3, 
“Restore on the XPR V7 Server”, on page 109, use the IP address of the 
virtual server and none of the following IP addresses:

• IP address of the cluster

• IP address of one of the two nodes for the internal cluster connection 
(Interconnect)

• IP addresses of the two nodes

The same applies for the computer names.

You find details on this in the setup guide OpenScape Xpressions 
ClusterInstallation.

b) It is irrelevant which of the two nodes is online during the data restore.
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